About this Manual

We’ve added this manual to the Agilent website in an effort to help you support your product. This manual is the best copy we could find; it may be incomplete or contain dated information. If we find a more recent copy in the future, we will add it to the Agilent website.

Support for Your Product

Agilent no longer sells or supports this product. Our service centers may be able to perform calibration if no repair parts are needed, but no other support from Agilent is available. You will find any other available product information on the Agilent Test & Measurement website, www.tm.agilent.com.

HP References in this Manual

This manual may contain references to HP or Hewlett-Packard. Please note that Hewlett-Packard's former test and measurement, semiconductor products and chemical analysis businesses are now part of Agilent Technologies. We have made no changes to this manual copy. In other documentation, to reduce potential confusion, the only change to product numbers and names has been in the company name prefix: where a product number/name was HP XXXX the current name/number is now Agilent XXXX. For example, model number HP8648A is now model number Agilent 8648A.
Installation/Service/Terminal Interface Guide

i80386 Emulator/Analyzer (HP 64789A)
Notice

Hewlett-Packard makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Hewlett-Packard assumes no responsibility for the use or reliability of its software on equipment that is not furnished by Hewlett-Packard.

© Copyright 1994, Hewlett-Packard Company.

This document contains proprietary information, which is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced or translated to another language without the prior written consent of Hewlett-Packard Company. The information contained in this document is subject to change without notice.

UNIX(R) is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Limited.

Hewlett-Packard Company
P.O. Box 2197
1900 Garden of the Gods Road
Colorado Springs, CO 80901-2197, U.S.A.

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth in subparagraph (C) (1) (ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013. Hewlett-Packard Company, 3000 Hanover Street, Palo Alto, CA 94304 U.S.A. Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-19(c)(1,2).
Printing History

New editions are complete revisions of the manual. Many product updates and fixes do not require manual changes, and manual corrections may be done without accompanying product changes. Therefore, do not expect a one-to-one correspondence between product updates and manual revisions.

Edition 1 64789-97000, August 1994
Edition 2 64789-97001, February 1995

Safety and Certification and Warranty

Safety information, and certification and warranty information can be found at the end of this manual on the pages before the back cover.
The HP 64789A Emulator

Description

The Hewlett-Packard Model 64789A emulator supports the Intel 80386DX microprocessor. In this manual, the HP emulator is referred to by Model Number 64789A, and the Intel microprocessor is referred to by i80386.

The emulator supports clock speeds up to 33 MHz (CLK2 speeds up to 66 MHz).

The emulator has a PGA-style connector. It can be plugged directly into the PGA connector on the demo board, and it can be plugged into a PQFP target system using optional accessories.

The emulator plugs into the modular HP 64700 instrumentation card cage and offers 80 channels of processor bus analysis with the HP 64794A or HP 64704A emulation-bus analyzer. Up to eight megabytes of emulation memory may be installed on the probe. High performance download is achieved through the use of a LAN (standard in HP 64700B; optional in HP 64700A) or RS-422 interface. An RS-232 port and a firmware-resident interface allow debugging of a target system at remote locations.

For software development, Microtec Research Inc. 8036 language tools are available on IBM-compatible personal computers and can be used through the HP Real-Time C Debugger Interface.

Language support is also available from several third-party vendors. This capability is provided through the HP 64700's ability to consume the Intel Standard OMF386 file format.
Features

HP 64789A Emulator

- Active probe emulator; supports the fastest processor speeds currently available from Intel. At the time this manual was printed, the emulator supported:
  - 33 MHz for i80386.
- No wait states to target memory
- Unlimited software breakpoints
- Symbolic support
- 36 inch cable and 219 mm (8.8") x 102 mm (4") probe
- Background and foreground monitors
- Consumes OMF86 and OMF386
- Multiprocessor emulation
  - synchronous start of 32 emulation sessions
  - cross triggerable from another emulator, logic analyzer, or oscilloscope
- Demo board and self test module included

Emulation-bus analyzer

- 80-channel emulation-bus analyzer
- Post-processed trace with symbols
- Eight events, each consisting of address, status, and data comparators
- Events may be sequenced eight levels deep and can be used for complex trigger qualification and selective store
Emulation memory

- Up to 8 Mbytes of emulation memory
- All emulation memory is dual-ported
- Mapping resolution is 256 bytes
- The wait states required for emulation memory depend on speed of CLK2 and the access speeds of the SIMMs installed on the emulation probe, as shown below:

<table>
<thead>
<tr>
<th>SIMM Access Speed</th>
<th>Runs with no Wait States</th>
<th>Requires 1 Wait State</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 nSEC</td>
<td>All CLK2 speeds</td>
<td>N/A</td>
</tr>
<tr>
<td>25 nSEC</td>
<td>CLK2 =&lt; 60 MHz</td>
<td>CLK2 &gt; 60 MHz</td>
</tr>
</tbody>
</table>
In This Book

This manual covers the Hewlett-Packard Model 64789A emulator for the Intel i80386 microprocessor. It is divided into the following parts:

Part 1, “Installation,” shows you how to install and connect all of the emulator/analyzer hardware in the card cage, connect the card cage to a PC, and connect the emulator probe into the demo board and into your target system.

Chapter 4 in Part 1 leads you through a detailed procedure designed to help you connect the emulator into an unknown target system and obtain satisfactory operation. Even if you have extensive emulator experience, you should read this chapter to become familiar with problems that are specific to the i80386 processor and emulator.

Part 2, “Service,” shows you how to install and update emulator/analyzer firmware, solve problems you may encounter while using the emulator/analyzer, and obtain replacement parts for the emulator/analyzer from Hewlett-Packard.

Part 3, “Terminal Interface Reference,” introduces the interfaces available to use with the emulator/analyzer, and shows you how to use the terminal interface for the emulator/analyzer.

This manual replaces the Terminal Interface Reference which accompanied earlier HP emulators. For information on the Terminal Interface, see Part 3.

You should read the book Concepts of Emulation and Analysis when you have the chance to do so; it contains a good conceptual introduction to the emulation process, and also describes how an emulation monitor works.

Another book, the HP 64700 Card Cage Installation/Service Guide, tells you more about installation and configuration of the HP 64700 Card Cage. If you have a problem with the emulator and don’t understand how to fix it, a listing of HP Sales and Service offices is in the Support Services Guide in the back of this binder.
Contents

Part 1 Installation Guide

1 Preparing the Emulator

Preparing the Emulator  4

What you need  5

Antistatic Precautions  6

Step 1. Install optional memory modules on Deep Analyzer card (if using the Deep Analyzer)  7
Step 2. Connect the emulator probe cables  9
Step 3. Install boards into the HP 64700 Card Cage  11
Step 4. Install emulation memory modules on emulator probe  24
Step 5. Connect the power cord  28

2 Connecting to a Host Computer

Step 1: Choose a system configuration  32
Step 2: Connect the LAN cable  32
Step 3: Install host software  33
Step 4: Update emulator firmware  33
Step 5: Configure the LAN parameters  34
To configure LAN parameters using the terminal interface  34
If "telnet" does not access the emulator  38

3 Connecting to the Demo Board

Installation  40

Step 1. Connect the emulator probe to the demo target system  41
Step 2. Apply power to the HP 64700  43
Step 3. Verify the performance of the emulator  44
4 Plugging the Emulator into a Target System

Plugging the Emulator into a Target System 46

Assumptions and Equipment you may need 47

No-Intrusion Plug-In 48

Make physical connection between emulator and target system 48
Power on the emulator 51
Configure the emulator for no intrusion 52
Reset the emulator 54
Start trace analyzer 54
Start target system 54
Determine if power and clock are present 55
Target power not detected 55
Target CLK2 not detected 56
Target RESET not released 57
Processor wait state 57
Examine execution start 58
If the data fetched for the first address is not correct 58
If the data fetched after the first address is not correct 59
If you cannot write/read memory (or I/O) correctly 60
If the program runs correctly for a while and then dies (assuming that it does not die when the processor is plugged in) 60
Program halts, no intrusion 61
Program shuts down, no intrusion 62
Program dies, no intrusion 62

Using Emulation Memory with no Intrusion 63

Specifying a CLK2 speed 63
Mapping the memory 65
Loading the memory 65
Run your program with emulation memory 66

Using the Background Monitor 68

Emulation with the background monitor 68
Using the Foreground Monitor 69
Monitor address 69
Considerations when using the foreground monitor and paging 69
Monitor selector 70
Manually making room in the GDT 70
Executing the foreground monitor 71

Dealing with Keep-Alive Circuitry by Customizing the Foreground Monitor 72
Bus-cycle monitor 72
Interrupt-response checking 72
Idle-loop detect 72
To disable and re-enable the keep-alive timer 73
To access the keep-alive address within the idle loop 73

Using Software Breakpoints and Execution Messages 74

Using the Reset Flying Lead 75
Reset switch method 75
Power-on circuit method 76

General Information about the Emulator 77
Timing specifications comparing the emulator with the 80386DX 77
Equivalent circuits interfacing target with processor 77
Part 2 Service

5 Installing/Updating HP 64700 Firmware

Installing/Updating HP 64700 Firmware 82
Step 1. Connect the HP 64700 card cage to your PC 83
Step 2. Install the firmware update utility 85
Step 3. Run PROGFLASH to update HP 64700 firmware 87
Step 4. Verify emulator performance 88

6 Solving Problems

To verify the performance of the emulator 91
What is pv doing to the Emulator? 93
Troubleshooting 94
To ensure software compatibility 94
To display the emulator status 96
To check the version of the terminal interface software 96
If the emulator appears to be malfunctioning 97
If you suspect the emulator is broken 97
If you have RS-232 connection problems 98
If emulation memory behavior is erratic 99
If you’re having problems with DMA 100
If the analyzer won’t trigger 100
If the analyzer triggers on a program address when it should not 100
If you see unexplained states in the trace list 101
If you see exclamation marks "!!" in count columns of the trace lists 101
If you see negative time or state counts in trace lists 102
If you do not see the counter overflow indication "!!" where you expected to see it in a trace list 102
If the performance verification reports massive pv failures 102

7 Parts List

Parts List 104
Part numbers for the B3637 floppies 104
What is an exchange part? 104
Part 3 Terminal Interface Reference

8 Using the Terminal Interface

When to Use the Terminal Interface 110
Learning About the Terminal Interface 111
To start the terminal interface 111
To view a list of available commands 112
To view help on individual commands 114
To view help on command syntax 114

Graphical Interfaces 115
Why use a graphical interface? 115

9 Specifications and Characteristics

Processor compatibility 118
Electrical 118
Real and protected addressing modes 118
Emulation memory 118
HP 64789A maximum ratings 119
HP 64789A AC electrical specifications 120
Signal loading specifications 122
Physical 123
Environmental 124
Regulatory compliance 124
BNC, labeled TRIGGER IN/OUT 125
Communications 125

Glossary

Index
Preparing the Emulator

How to connect the emulator probe and power cord.
Preparing the Emulator

This chapter shows you how to install the emulation and analysis hardware in the emulator card cage.

The installation tasks are described in the following steps:

1. Install optional memory modules on the deep analyzer card, if desired.
2. Connect the HP 64789A emulator probe to the HP 64748C emulator control card.
3. Install cards into the HP 64700 card cage.
4. Install emulation memory modules on the emulator probe.
5. Connect a power cord to the HP 64700 Card Cage.
What you need

Equipment supplied

The minimum system contains:

- HP 64789A i80386 PGA Emulator Probe
- Demo target system (shipped with the emulator probe).
- HP 64748C Emulation Control card.
- HP 64794A/C/D Emulation-Bus Analyzer (deep analyzer) card, or HP 64704A 80-channel Emulation-Bus Analyzer (1K analyzer) card.
- 80-Channel Analyzer Extender Ribbon Cable.
- HP 64700A or HP 64700B Card Cage.

Optional parts are:

- HP 64172A 256-Kbyte Memory Modules for additional memory depth.
- HP 64172B 1-Mbyte Memory Modules for additional memory depth.
- HP 64173A 4-Mbyte Memory Modules for additional memory depth.
- HP 64701A LAN Interface card (HP 64700A only).

Equipment and tools needed

In order to install and use the i80386 emulation system, you need:

- Flat-blade screwdriver with shaft at least 5 inches long (13 mm approx).
- Torx T-10 screwdriver (if installing the optional LAN card for the HP 64700A).

The illustrations in this manual show the HP 64700B Card Cage. The locations of some components may be slightly different if you are using an HP 64700A Card Cage.
Antistatic Precautions

Printed-circuit boards contain electrical components that are easily damaged by small amounts of static electricity. To avoid damage to the emulator boards, follow these guidelines:

- If possible, work at a static-free workstation.
- Handle the boards only by the edges; do not touch components or traces.
- Use a grounding wrist strap that is connected to the HP 64700 chassis.

Note

If you already have an HP 64700-Series Card Cage and want to remove the existing emulator and insert an HP 64789A emulator in its place, the HP 64700-Series generic firmware and analyzer firmware may NOT be compatible, and the software will indicate incompatibility. In this event, you must purchase a Flash EPROM board to update the firmware. Instructions for installing this board and programming it from a PC or HP 9000 are provided in the HP 64700 Card Cage Installation/Service manual. Instructions for installing and updating emulator firmware are covered in Chapter 5, "Installing/Updating Emulator Firmware" in this manual.

Note

If you already have an HP 64700-Series Card Cage and want to remove the 1K analyzer and install the deep analyzer in its place, the analyzer firmware will be updated by your installation because the analyzer firmware is contained on the analyzer card.
Step 1. Install optional memory modules on Deep Analyzer card (if using the Deep Analyzer)

**Observe antistatic precautions**

With no optional memory modules installed on the deep analyzer card, the trace memory depth is 8K. If you are going to use the deep analyzer with this default trace memory depth, skip this step.

1. Determine placement of the optional memory modules. Two types of modules may be installed: 256-Kbyte (HP 64172A), and 1-Mbyte (HP 64172B). Either module type may be installed in the banks on the analyzer card. Do not use HP 64171A/B or HP 64173A memory modules; they are too slow.

If you install no memory modules, the deep analyzer will have 8K maximum memory depth. If you install four 256-Kbyte memory modules, the analyzer will have 64K maximum memory depth. If you install four 1-Mbyte memory modules, the analyzer will have 256K maximum memory depth.

If you install a combination of 256-Kbyte memory modules and 1-Mbyte memory modules, the analyzer will have 64K maximum memory depth. All four connectors must have memory modules installed before the analyzer depth will be increased.
To ensure correct installation of optional memory modules on the deep analyzer card, there is a cutout at one end of the memory modules so they can only be installed the correct way.

To install a memory module:

Align the groove in the memory module with the alignment rib in the connector.

Align the cutout in the memory module with the projection in the connector.

Place the memory module into the connector groove at an angle.

Firmly press the memory module into the connector and make sure it is completely seated.

Rotate the memory module forward so that the pegs on the connector fit into the holes on the memory module.

Make sure the release tabs at each end of the connector snap around the memory module to hold it in place.
Step 2. Connect the emulator probe cables

Three ribbon cables connect the HP 64748C emulation control card to the HP 64789A emulator probe.

The shortest cable connects from J1 of the emulation control card to J3 of the emulator probe. The medium length cable connects from J2 of the emulation control card to J2 of the emulator probe. The longest cable connects from J3 of the emulation control card to J1 of the emulator probe.

Make sure the cable connectors are seated. There are stainless steel clips on the cable connectors; these must be properly latched inside the sockets. Otherwise, the cables will work loose and you will see erratic operation. See illustration next page (step 2).
Chapter 1: Preparing the Emulator

Step 2. Connect the emulator probe cables

2. When inserting cable connectors into the sockets, press inward on the connector clips so that they hook into the sockets as shown. The order of connecting cables was given in step 1.

3. Connect the other ends of the cables to the emulator probe. Make sure the stainless steel clips on the cable connectors are properly latched within the sockets.
Step 3. Install boards into the HP 64700 Card Cage

**WARNING**
Before removing or installing parts in the HP 64700 Card Cage, make sure that the card cage power is off and that the power cord is disconnected.

**CAUTION**
Do NOT stand the HP 64700 Card Cage on the rear panel. You could damage the rear panel ports and connectors.

1. Use a ground strap when removing or installing boards into the HP 64700 Card Cage to reduce the risk of damage to the circuit cards from static discharge. A jack on the rear panel of the HP 64700 Card Cage is provided for this purpose.
2. Turn the thumb screw and remove the top cover by sliding the cover toward the rear and up.
Chapter 1: Preparing the Emulator

Step 3. Install boards into the HP 64700 Card Cage

3. Remove the side cover by unsnapping the two latches and lifting off.

4. Remove the card supports.
5 First, completely loosen the four egress thumb screws.

To remove emulator cards, insert a flat blade screwdriver in the access hole and eject the emulator cards by rotating the screwdriver.
6. Insert a screw driver into the third slot of the right side of the front bezel, push to release catch, and pull the right side of the bezel about one-half inch away from the front of the HP 64700. Then, do the same thing on the left side of the bezel. When both sides are released, pull the bezel toward you approximately 2 inches.

Be careful because the plastic ears are easily broken on the front bezel.
7 Lift the bezel panel to remove. Be careful not to put stress on the power switch extender.

8 If you're removing an existing analyzer card that provides external analysis, remove the right-angle adapter board by turning the thumb screws counterclockwise.
9 To remove the analyzer card, insert a flat blade screwdriver in the access hole and eject the analyzer card by rotating the screwdriver.

Do not remove the system control board. This board is used in all HP 64700 emulation and analysis systems.
10 Install the analyzer and emulation control cards. The analyzer is installed in the slot next to the system control card. The emulation control card is installed in the second slot from the bottom of the card cage. The software performance analyzer card may occupy any slot between the emulation-bus analyzer and the emulation control card. These cards are identified with labels that show their model numbers and serial numbers. Note that components on the analyzer card face the opposite direction to the other cards.

To install a card, insert it into the plastic guides. Make sure the connectors are properly aligned; then, press the card into the mother board socket. Ensure that each card is seated all the way into its socket. If the cards can be removed with your fingers, the cards are NOT seated all the way into the mother board sockets.

Attach the ribbon cable from the emulation control card to the analyzer card, and to the software performance analyzer, if installed. Tighten the thumbscrews that hold the emulation control card to the cardcage frame.
11 Connect the +5 V power cable to the connector in the HP 64700 front panel.
12 To reinstall the front bezel, be sure that the bottom rear groove of the front bezel is aligned with the lip as shown below.
13 This step applies only to the HP 64700A. The HP 64700B has a built-in LAN interface.

Before you install the LAN card, you must remove the rear panel cover plate that is replaced by the bracket shown in the figure below.

To install the LAN card, position the BNC and 15-pin connectors of the LAN card through the openings in the rear panel, press the card into the mother board socket, secure the card with the two Torx T-10 screws, and mount the bracket to the rear panel with the four Torx T-10 screws.

14 This step applies only to the HP 64700A. If you wish to install the flash card (used for updating firmware, see chapter 5), refer to the diagram above. Install the flash card in any available slot between the 80-channel analyzer card and the HP 64748C control card in the cardcage. Insert the flash card in the plastic guides. Make sure the connectors are properly aligned. Then press the card all the way into the mother board sockets.
Chapter 1: Preparing the Emulator

Step 3. Install boards into the HP 64700 Card Cage

15 Install the card supports.

16 To install the side cover, insert the side cover into the tab slots and fasten the two latches.
17 Install the top cover in reverse order of its removal, but make sure that the side panels of the top cover are attached to the side clips on the frame.
Step 4. Install emulation memory modules on emulator probe

Observe antistatic precautions

1. Remove plastic rivets that secure the plastic cover on the top of the emulator probe, and remove the cover. The bottom cover is only removed when you need to replace a defective active probe on the exchange program.
2 Determine the placement of the emulation memory modules. Three types of modules may be installed: 256 Kbyte (HP 64172A), 1 Mbyte (HP 64172B), and 4 Mbyte (HP 64173A). Any of the emulation memory modules can be installed in either memory slot on the probe.

If you install 4-Mbyte memory modules, a configuration question will ask if CLK2 is greater than 60 MHz. If you answer yes, 1 wait state will be added by the emulator to all accesses to these memory modules.

Do not use HP 64171A/B memory modules. They are too slow.

Memory in slot 0 is divided into four equal blocks. Memory in slot 1 is divided into two equal blocks. For maximum flexibility, HP suggests you install the largest memory module into slot 0 if you have two different size memory modules.

If you need new rivets or washers to complete this installation procedure, refer to Chapter 7, "Parts List," for the part number of the Plastic Rivets Kit.
3 Install emulation memory modules on the emulator probe. There is a cutout at one end of the memory modules so they can only be installed the correct way.

To install a memory module:

1. Align the groove in the memory module with the alignment rib in the connector.
2. Align the cutout in the memory module with the projection in the connector.
3. Place the memory module into the connector groove at an angle.
4. Firmly press the memory module into the connector and make sure it is completely seated.
5. Rotate the memory module to the vertical position so that the pegs on the connector fit into the holes on the memory module.
6. Make sure the release tabs at each end of the connector snap around the memory module to hold it in place.
4 Replace the plastic cover, and insert new plastic rivets (supplied with the emulator) to secure the cover.
Step 5. Connect the power cord

The HP 64700B automatically selects the 115 Vac or 220 Vac range. In the 115 Vac range, the HP 64700B will draw a maximum of 345 W and 520 VA. In the 220 Vac range, the HP 64700B will draw a maximum of 335 W and 600 VA.

If you have the emulator installed in an HP 64700A card cage, select the line voltage using a thumb-wheel switch inside the power control module on the rear panel of the card cage. The input frequency must be in the range of 48 to 66 Hz. At 115 VAC, the emulator will draw a maximum of 3.0 A. At 220 VAC, it will draw a maximum of 1.5 A.

The HP 64700 is shipped from the factory with a power cable appropriate for your country. You should verify that you have the correct power cable for installation.

If the cable you received is not appropriate for your electrical power outlet type, contact your Hewlett-Packard sales and service office.
1  Connect the power cord and turn on the HP 64700.

The line switch is a pushbutton located at the lower, left-hand corner of the front panel. To turn ON power to the HP 64700, push the line switch button in to the ON (1) position. The power lamp at the lower, right-hand corner of the front panel will light.
Connecting to a Host Computer

How to connect the emulator to a PC or terminal.
Chapter 2: Connecting to a Host Computer

Step 1: Choose a system configuration

As you follow the steps in this chapter, you will need to refer to the 64700 Card Cage Installation/Service Guide.

Step 1: Choose a system configuration

1. Decide how you will connect the emulator to your host computer. Refer to the "Concepts" chapter in the 64700 Card Cage Installation/Service Guide.

2. If you will be using a LAN connection, continue with the steps in this chapter.

   If you will be using a serial connection, refer to the information in the 64700 Card Cage Installation/Service Guide; you may skip the rest of this chapter.

Step 2: Connect the LAN cable

- Connect the LAN to either the BNC connector or the 15-pin AUI connector.

The card cage can communicate with computers on an IEEE 802.3 or Ethernet Local Area Network. (If you have a 64700A card cage, you need the HP 64701A LAN card to connect to a LAN.) You can use either of two LAN connectors:

- A BNC connector that can be directly connected to a ThinLAN (HP's implementation of IEEE 802.3 Type 10BASE2) cable. The card cage provides the functional equivalent of a Medium Attachment Unit (MAU) for ThinLAN.

- A 15-pin connector for an Attachment Unit Interface (AUI) cable. The AUI cable allows you to connect to an off-board MAU for ThinLAN, a ThickLAN (HP's implementation of IEEE 802.3 Type 10BASE5)
connection, or to a Pod for a StarLAN 10 (HP’s implementation of IEEE 802.3 Type 10BASE-T) connection.

**CAUTION**

CORRUPTED DATA! The LAN connection to the BNC will maintain software integrity and can maintain communication when subjected to low levels of Electrostatic Discharge (ESD) directly to the LAN connector.

When operating in an environment where ESD pulses are in excess of 2500 volts, using a ThinMAU adapter (instead of a direct connection) is more reliable and less susceptible to data corruption from ESD to the LAN cable.

Use either the BNC or the AUI connector. Do NOT use both. The LAN interface will not work with both connected at the same time.

---

**Step 3: Install host software**

If you have not already done so, install the LAN software on your host computer.

---

**Step 4: Update emulator firmware**

If you did not receive your HP 64700 Card Cage and HP 64789A Emulator together (e.g., you are installing your HP 64789A Emulator in a card cage that had a different emulator installed in it), update the emulator firmware according to the steps in Chapter 5, "Installing/Updating Emulator Firmware."
Step 5: Configure the LAN parameters

- To configure the LAN parameters using the HP Real-Time C Debugger interface on a PC, refer to the instructions in your Real-Time C Debugger interface manual.

To configure LAN parameters using the terminal interface

1. Set all of the rear panel switches to the down position. This will set the serial port (Port A on a 64700A card cage) to 9600 baud and DCE.

2. Connect an ASCII terminal to the serial port with a 25-pin RS-232 cable.

   You can also connect to a computer’s RS-232 port and use a terminal emulation program on the computer. Refer to the "Connecting the HP 64700 Using RS-232/RS-422" chapter in the 64700 Card Cage Installation/Service Guide.

3. Turn ON the emulator card cage. Press the terminal’s <RETURN> key a couple times. You should see the "R>" prompt.

4. Display the current LAN configuration values by entering the `lan` command:

   ```
   R>lan
   lan -i 0.0.0.0
   lan -g 0.0.0.0
   lan -s 0.0.0.0
   lan -p 6470
   Ethernet Address : 08000903212f
   ```

   Note the Ethernet Address, also known as the link-level address. This address is preassigned at the factory, and is printed on the rear panel.
Enter the `lan -i <internet> [-g <gateway>] [-s <subnet>] [-p <port>]` command.

The lan command parameters are:

- `-i <internet>`: The Internet Address must be obtained from your local system administrator. The value is entered in integer dot notation. For example, 192.35.12.6 is an Internet Address.

- `-g <gateway>`: The Gateway Address is also an Internet Address and is entered in integer dot notation. This entry is optional and will default to 0.0.0.0, meaning all connections are to be made on the local network or subnet. If connections are to be made to workstations on other networks or subnets, this address must be set to the address of the gateway machine. The gateway address must be obtained from your local system administrator.

- `-s <subnet>`: The Subnet Mask (in integer dot notation) is optional and only available when using the HP 64700A. It defaults to 0.0.0.0. The default is valid only on networks that are not subnetted. (A network is subnetted if the host portion of the Internet address is further partitioned into a subnet portion and a host portion.) If the network is subnetted, a subnet mask is required in order for the emulator to work correctly. The subnet mask should be set to all "1"s in the bits which correspond to the network and subnet portions of the Internet address and all "0"s for the host portion. The subnet mask must be obtained from your system administrator.
Chapter 2: Connecting to a Host Computer

To configure LAN parameters using the terminal interface

-p<port> This changes the base TCP service port number. The host computer interfaces communicate with the emulator through two TCP service ports. The default base port number is 6470. The second port has the next higher number (default 6471). If you change the base port, the new value must also be entered in the /etc/services file on the host computer. For example, you could modify the line:

```
hp64700 6470/tcp
```

The default numbers (6470, 6471) can be changed if they conflict with some other product on your network. TCP service port numbers must be greater than 1024.

For example, to assign an Internet Address of 192.6.94.2 to the emulator, enter the following command:

```
R>lan -i 192.6.94.2 <RETURN>
```

The Internet Address and any other LAN parameters you change are stored in nonvolatile memory and will take effect the next time the emulator is powered off and back on again.

6 Turn power to the emulator OFF, and connect the the emulator to your network. This connection can be made by using either the 15 Pin AUI connector or the BNC connector.

7 Set the rear panel dip switches to indicate the type of connection that is to be made:

Switch 16 must be set to one (1) indicating that a LAN connection is being made.

Switch 15 should be zero (0) if you are connecting up to the BNC connector or set to one (1) if a 15 pin AUI connection is made.

Switch 14 should be zero (0).

Set all other switches to zero (0).
8 Turn ON power to the emulator card cage.

9 Verify your emulator is now active and on the network by issuing a `telnet` to the Internet Address. For example:

```
$ telnet 192.6.94.2 <RETURN>
```

This connection will give you access to the built-in terminal interface. To exit from this telnet session, type `<CTRL>d` at the emulator prompt.

The next time LAN parameters need to be configured, telnet to the emulator and use the terminal interface `lan` command.
If "telnet" does not access the emulator

You must use the telnet command on the host computer to access the emulator's built-in terminal interface. After powering up the emulator, it takes a minute before it can be recognized on the network. After a minute, try the telnet <internet address> command.

If telnet does not make the connection:

☐ Make sure that you have connected the emulator to the proper power source and that the power light is lit.

☐ Make sure that the LAN cable is connected. Refer to your LAN documentation for testing connectivity.

☐ Make sure the rear panel communication configuration switches are set correctly. Switch settings are only used to set communication parameters when power is turned OFF and then ON.

☐ Make sure that the Internet Address is set up correctly. You must use the RS-232/RS-422 port to verify this that the Internet Address is set up correctly. While accessing the emulator via the RS-232/RS-422 port, run performance verification on the LAN interface hardware with the lanpv command.

If telnet makes the connection, but no terminal interface prompt (for example, R>, M>, U>, etc.) is supplied:

☐ It's possible that the emulator interface software is in the process of running a command (for example, if a repetitive command was initiated from telnet in another window). You can use <CTRL>c to interrupt the repetitive command and get the terminal interface prompt.

☐ It's also possible for there to be a problem with the emulator firmware while the LAN interface is still up and running. In this case, you must cycle power on the emulator card cage.
Connecting to the Demo Board

How to connect the emulator to the demonstration target system.
Installation

This chapter shows you how to connect the emulator to the demo target system which is shipped with the emulator. It also shows you how to verify installation by starting the emulator/analyzer interface for the first time.
Step 1. Connect the emulator probe to the demo target system

1. With HP 64700 power OFF, connect the emulator probe to the demo target system. When you install the probe into the demo board, be careful not to bend any of the pins. Do not insert the probe of the i80386 emulator into the demo board socket incorrectly. Be very careful.
2. Connect the power supply wires from the emulator to the demo target system. The 3-wire cable has one power wire and two ground wires. When attaching the 3-wire cable to the demo target system, make sure the connector is aligned properly so that all three pins are connected.

3. Connect the reset flying lead from the probe to the demo board.
Step 2. Apply power to the HP 64700

1. Connect the power cord and turn on the HP 64700.

The line switch is a push button located at the lower, left-hand corner of the front panel. To turn ON power to the HP 64700, push the line switch button in to the ON (1) position. The power lamp at the lower, right-hand corner of the front panel will light.
Step 3. Verify the performance of the emulator

1 Establish communication with the emulator from your host or ASCII terminal and obtain a prompt (such as **R>**).

2 Enter: `pv 1 <return>`

   The emulator will print the results of its test, followed by a prompt.

3 Enter: `ver <return>`

   The emulator will print some version numbers and the status of the memory modules on the probe, followed by a prompt.

4 Enter: `<CTRL>d`

   This command will end the emulation session.

5 If the emulator reported any failures, refer to Chapter 6, "Solving Problems."

---

**Examples**

If you are using a LAN, you can use the telnet capability with the built-in Terminal Interface:

1 From your host computer enter the command:
   `telnet <emulator_name>.

2 Now enter the command: `pv 1`

Note: the HP 64700 telnet capability is not supported by Hewlett-Packard.
Plugging the Emulator into a Target System
Plugging the Emulator into a Target System

The purpose of this section is to help you plug the emulator into your target system. Most "plug-ins" are simple but due to hardware and software differences, some can be difficult. Even if you have extensive emulator experience, you should read this chapter to become familiar with issues or potential problems that are specific to the i80386 processor and emulator.

This chapter is divided into two sections: a set of step-by-step instructions for plugging the emulator into a target system, and general information about the emulator signals. At appropriate places in the step-by-step instructions, you will be referred to the Specifications Chapter. You won't have to spend time reading about product specifications that you don't care about. Note that the step-by-step instructions do not have an exhaustive list of potential problems. The list is limited to the most likely causes of problems. These should aid you in finding the source of your plug-in problems.

These step-by-step instructions will lead you through the following:

- Assumptions and equipment you may need.
- No-intrusion plug-in.
- Using emulation memory with no intrusion.
- Using the background monitor.
- Using the foreground monitor.
- Dealing with keep-alive circuitry by customizing the foreground monitor.
- Using software breakpoints and execution messages.
- Using the Reset Flying Lead.
Assumptions and Equipment you may need

The directions in this chapter use the RTC interface. They assume that the connection between the emulator and your PC has been made, the emulator firmware has been installed or updated according to Chapter 5, the probe is connected to the three cables from the HP 64700 Card Cage, and the emulator has passed its performance verification (PV) in Chapter 3.

To deal with problems that may occur during this procedure, you may need the following equipment:

- Oscilloscope. Two channels. Analog band width should be at least 500 MHz. If possible, single-shot sampling rate should be greater than 1 Gsample/second.
- Logic/timing analyzer. At least 16 channels. Sampling rate of timing analyzer should be at least twice the speed of CLK2 in your target system.

If you need to measure any internal signals, such as CLK2, remove the top plastic cover from the emulator and make the measurements on the pins of the emulator connector. The pins are through-hole pins, with the socket on the bottom of the board, so probing the pins is easy. Remember to use as short a ground lead as possible to achieve a realistic view of the signal. All signals measured will be at the emulator probe's PGA connector. Ground pins are plentiful and always nearby.

**CAUTION**

Always turn off the target system and then the emulator (in that order) prior to disconnecting them or making any other physical changes (such as soldering). It is also a good idea to turn both systems off when attaching probe leads to surface-mount chip leads to avoid problems caused by momentarily shorting adjacent leads.
No-Intrusion Plug-In

This section of Chapter 4 verifies operation of the hardware interface between the emulator and the target system. It is called "no_intrusion" because it makes no deliberate break into the monitor while the emulator is running. In this section, you will do the following:

- Make physical connection between the emulator and the target system.
- Configure the emulator for no intrusion.
- Start the analyzer and the target system.
- Verify the presence of power and the clock.
- Examine execution start which verifies the analyzer interface, and CPU operation in your target environment.

The emulator should work in any system designed to meet the worst-case timing and electrical specifications of the 33 MHz, 80386DX processor, as specified by Intel. To be more robust and to implement certain features, the emulator adds delay to some lines (such as data and ADS), and requires more setup time on some lines (such as the data lines). However, typically (as in a lab setting) you should encounter no problems.

Make physical connection between emulator and target system

1. Turn power off to the target system, and then to the emulator.
2. Choose the connection type: direct, direct with headers, or Flexible Cable (shown below).

CAUTION
Damage from Static Discharge. Wear the static strap (supplied with the HP 64700 Card Cage) whenever handling the emulator.
The best way to connect to the target system is to directly connect the PGA of the emulator probe to a PGA socket on your target system. This yields the cleanest electrical connection and gives the best probability of a successful plug-in. The signal timings listed in Chapter 9, "Specifications and Characteristics," were calculated using this direct connection.

**CAUTION**

Damage to target system and emulator. Align pin A1 on the target system with pin A1 on the emulator. (Some versions of this emulator label pin A1 as "Pin 1" on the top plastic case of the emulator probe, instead of "Pin A1"). Failure to align pins correctly will either short the power supply on the target system or cause permanent damage to both the target system and the emulator. Double check your connections before applying power.

If a direct connection is not possible, the next best way to connect the emulator probe to your target system is to stack several PGA pin protector sockets between the emulator and your target system. This will degrade the electrical performance somewhat, but the performance will be degraded much less than it will be when using the Flexible Cable. Under most loading conditions, five stacked headers add about 0.5 nsec delay in signals and relatively little ringing.
If you cannot connect the emulator probe directly to your target system or use several PGA pin protector sockets to make the connection, use the Flexible Cable. Connecting through the Flexible Cable can introduce significant "ringing" on your CLK2 line as well as other lines (such as address and data lines) simply because the Flexible Cable is a fairly long physical "stub" on your signal lines, which is not present when the processor is plugged in. Furthermore, the Flexible Cable has no ground planes, so there are significant transmission line effects using this cable. Nevertheless, it is quite usable at frequencies below about 25 MHz. Using the Flexible Cable may require that you slow your clock edges or add wait states; it is impossible to know until you try it. Also, be aware that the signal timings in Chapter 9, "Specifications and Characteristics," do not allow for the additional delays caused by using the Flexible Cable. Depending on loading, the delay added by the Flexible Cable can be between 1 and 3 ns in either direction.
The Flexible Cable has a 15 X 15 pin arrangement, and the 80386 emulator uses a 14 X 14 pin arrangement. Verify proper alignment of the socket, male header, and Flexible Cable. You might paste a paper dot on the Flexible Cable to mark pin 1 on both connectors before connecting the Flexible Cable between the emulator probe and the target microprocessor.

**Power on the emulator**

Turn on power to the emulator card cage. Do not yet apply power to your target system. That step comes after you have configured the emulator.
Configure the emulator for no intrusion

This step configures the monitor to do as little as possible.

1 Choose Execution→Reset (ALT, E, E).

2 In the emulator interface, choose the Settings→Emulator Config→Hardware... (ALT, S, E, H) command.

3 Make sure the boxes for "Enable Software Breakpoints" and "Enable Execution Trace Messages" are not checked.

Leaving the Enable Software Breakpoints and Enable Execution Trace Messages boxes unchecked prevents breaking into the monitor if your software makes use of the debug registers because these two capabilities also make use of the debug register.

4 Choose RealTime→Monitor Intrusion→Disallowed (ALT, R, T, D ) in case your system cannot allow breaks while running.

5 If you have been executing programs without the emulator, do not map any emulation memory yet. Instead, go forward to "Start trace analyzer." Mapping emulation memory may make it more difficult to diagnose problems.

6 If you cannot run from reset out of your own target system memory, map memory as follows:

Choose Settings→Emulator Config→Memory Map... (ALT, S, E, M).

range: 0xfffff00..0xffffffff
Use Target Rdy: yes
Use dual-ported memory: yes
7 Choose the OK button.

8 Use the memory window to create the following program:

```
ffffffffff0 90 nop   ; 80386 reset address
ffffffffff1 90 nop
ffffffffff2 90 nop
ffffffffff3 90 nop
ffffffffff4 90 nop
ffffffffff5 90 nop
ffffffffff6 90 nop
ffffffffff7 90 nop
ffffffffff8 feeb jmp $
```

This test will use dual-port memory because you can change the content of dual-port memory even when the processor is reset or there is no target power. SIMM memory cannot be changed unless the processor is running (so that it can execute the monitor), and CLK2 is present in the target system.

Continue with the instructions below. To deal with problems you may encounter, refer to the section titled, "Using emulation memory with no monitor," later in this chapter.
Reset the emulator

- Choose the Execution→Reset (ALT, E, E) command.

This step forces the processor to the reset state.

Start trace analyzer

1 Choose the Trace→Trigger Store (ALT, T, T) command.

2 Start the analyzer, configured to store all states.

3 Choose the "Clear" button, and then the "OK" button.

Because you reset the processor in the first step, the analyzer’s internal pipeline is initialized properly so the analyzer will not miss the first one or two instruction fetches.

Start target system

1 Choose the Execution→Run... (ALT, E, R) command.

2 Select User Reset in the Run dialog box.

3 Choose the Run button.

4 Turn power on to your target system.

The Execution→Run... (ALT, E, R) from User Reset command causes the emulator to start running as soon as power is applied. The target system
should start executing normally (behave as if an i80386 microprocessor is plugged in). If the target system does execute normally, skip the remaining procedures in this section and go to the section titled, "Using the Background monitor" later in this chapter. If the target system does not execute normally, continue with the next paragraph.

Determine if power and clock are present

Read the status in the "Status" window. Then continue with the paragraph appropriate for the status shown, indicated in the following table.

<table>
<thead>
<tr>
<th>If the status window shows:</th>
<th>Begin with paragraph titled:</th>
</tr>
</thead>
<tbody>
<tr>
<td>no power</td>
<td>Target power not detected</td>
</tr>
<tr>
<td>no clock</td>
<td>Target CLK2 not detected</td>
</tr>
<tr>
<td>still in &quot;Reset&quot; mode</td>
<td>Target RESET not released</td>
</tr>
<tr>
<td>processor wait state</td>
<td>Processor wait state</td>
</tr>
<tr>
<td>any other status indication</td>
<td>Examine execution start</td>
</tr>
</tbody>
</table>

**Target power not detected**

**CAUTION**

Turn power off to your target system and verify that you have connected the emulator to the target system correctly. If your connection is misaligned by one rank of pins, this problem will occur.

This prompt means no target power has been detected. Usually this is caused by a poor physical connection. Make sure the PGA connectors are all parallel and plugged in as far as they will go.
Use the oscilloscope to verify that power supplied to the emulator target is at least 4.5 volts and is "clean" (that is, it does not oscillate by more than a few millivolts). If the voltage is below 4.5 volts, increase the current or voltage of your power supply. The emulator requires more current than the processor alone because the emulator powers the processor plus a pull-up resistor and some buffers. Refer to the "Power Requirements" in Chapter 9, "Specifications and Characteristics," for exact information.

If the power supply is oscillating significantly, you may need to increase the value of the bypass capacitors around the processor socket, as specified in the Intel386 DX Hardware Reference Manual (Intel's order number 231732-005). If necessary, simply solder some bypass capacitors in parallel with those that are already in use.

**Target CLK2 not detected**

This prompt indicates that no CLK2 signal is being detected. This is usually caused by a poor physical connection. Make sure the PGA connectors are parallel and plugged in as far as they will go.

Use an oscilloscope to look at CLK2 on the emulator probe. Verify the following:

- CLK2 is oscillating at the frequency you think it should be.
- CLK2 is a square wave.
- CLK2 high voltage is greater than 3.7V.
- CLK2 low voltage is less than 0.8V.

The emulator buffers the CLK2 signal with a transistor buffer in order to reduce the loading on the signal and to reduce the 'stub length' of the line. However, if you are using the Flex Adapter, this 'stub' can be significant, causing ringing and other transmission-line problems.

Possible solutions include:

- Use a 'controlled edge rate' clock driver.
- Insert a small-value resistor (about 3 to 5 ohms) in series with the CLK2 signal.
- Run the target system at a slower speed. This gives the CLK2 signal time to settle, time for any logic circuitry receiving overshoots or undershoots to unsaturate, and time for delays caused by transmission-line problems to settle out.
Target RESET not released

1 Choose Trace→Halt (ALT, T, H).

2 View the trace list.

If the trace list shows no cycles were executed, RESET was never released. Investigate the conditions that must be satisfied before the target system will release the RESET line and use the logic analyzer or oscilloscope to determine why these conditions did not occur. For example, in a multiple-board system, an external master may hold the processor in the reset state while it uses DMA to do a checksum of memory. Because this emulator does not support DMA accesses into emulation memory, the checksum will fail if code is in emulation memory hardware. Consequently the external master may choose to not release the RESET line.

If there are any cycles shown in the trace list, RESET was released, and then reasserted. In this case, go to the paragraph titled, "Examine execution start."

Processor wait state

This status indicates that the processor started a read cycle or a write cycle but did not complete it. This means that the READY# signal was not asserted (high) correctly. Check the timing. If you are using 4-Mbyte SIMMs, refer to the paragraph titled, "Specifying a CLK2 speed," later in this chapter.
Examine execution start

After problems with the power and clock have been fixed, look at the trace by
displaying the trace window. The trace list should start with address
0fffff0h and be similar to the following:

<table>
<thead>
<tr>
<th>Line</th>
<th>addr, H</th>
<th>80386 Mnemonic</th>
<th>stat, H</th>
<th>count, R</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>fffffff0</td>
<td>00e05b3aH code read</td>
<td>b709</td>
<td>----------</td>
</tr>
<tr>
<td>1</td>
<td>ffffffff4</td>
<td>2f3231f0H code read</td>
<td>3709</td>
<td>4.48uS</td>
</tr>
<tr>
<td>2</td>
<td>ffffffff8</td>
<td>392f3231H code read</td>
<td>3709</td>
<td>4.52uS</td>
</tr>
<tr>
<td>3</td>
<td>000fe058</td>
<td>e9000000H code read</td>
<td>3709</td>
<td>4.48uS</td>
</tr>
<tr>
<td>4</td>
<td>000fe05c</td>
<td>a3f1a2a2H code read</td>
<td>a709</td>
<td>5.12uS</td>
</tr>
<tr>
<td>5</td>
<td>000fe060</td>
<td>a5837102H code read</td>
<td>3709</td>
<td>4.48uS</td>
</tr>
<tr>
<td>6</td>
<td>000f8300</td>
<td>e6e4fca9H code read</td>
<td>3709</td>
<td>4.52uS</td>
</tr>
<tr>
<td>7</td>
<td>000f8300</td>
<td>e6e4fca9H code read</td>
<td>a709</td>
<td>5.10uS</td>
</tr>
<tr>
<td>8</td>
<td>000f8304</td>
<td>06750a8AH code read</td>
<td>3709</td>
<td>4.48uS</td>
</tr>
<tr>
<td>9</td>
<td>00000064</td>
<td>xxxxxxx00H read i/o</td>
<td>37e5</td>
<td>1.36uS</td>
</tr>
<tr>
<td>10</td>
<td>000f8308</td>
<td>e90957e9H code read</td>
<td>3709</td>
<td>4.50uS</td>
</tr>
</tbody>
</table>

You may need to choose Trace→Halt (ALT, T, H), and from the Trace
window’s control menu, choose the Display→Bus Cycle ON (ALT, -, D, B)
command to obtain the display of execution start.

☐ Check to see that the address of the first state in your trace list is fffffff0.

☐ Check to see if the data that was fetched is correct.

If the data fetched for the first address is not correct

☐ Check to see if your target system has special circuitry that needs to be
active in order for the first fetch to be correct. For example, many target
systems do not have memory at high address space. Instead, they have a
special circuit that forces a jump instruction on the data bus as the first
instruction after a RESET.

☐ Make sure monitor intrusion is disallowed while running from reset
(RealTime→Monitor Intrusion→Disallowed (ALT, R, T, D)). Otherwise, the
first cycle of the emulator may be used to read memory to update a display
instead of being used to fetch the reset address.
The emulator adds a few states of delay to the standard RESET cycle, and this delay may be affecting your circuit. Because 80386DX RESET-to-ADS times are fairly long, the design of the emulator anticipates that any such circuits will key off of the ADS, and not count cycles. If your target system circuit counts cycles, you may need to add one or more cycles to use the emulator. Furthermore, you will not be able to use the 'enable software breakpoints' and 'enable execution messages' options from reset because using these options causes a much longer delay from RESET to the first occurrence of ADS.

See if your target system circuitry uses DMA to place the data into memory prior to the first fetch. The emulator allows DMA (HOLD) to occur at all times (even when the emulator is executing in the background monitor) so the emulator should not effect DMA transactions. However, the additional states of RESET may confuse synchronization circuitry in your target system. Read the previous paragraph with your DMA in mind.

Check that the additional delay for ADS is not causing problems for circuitry in your target system. If the delay is causing problems, you may need to have your system add a wait state. Refer to the section titled, "Timing specifications comparing the emulator with the 80386DX," later in this chapter, and to Chapter 9, "Specifications and Characteristics," for detailed timing information.

Check that CLK generation (from the falling edge of RESET) is correct. If not, invert it.

Check that your data meets the additional setup time required by the emulator. If it does not, try adding a wait state.

If the data fetched after the first address is not correct

Usually if the first data fetched is correct, all data fetched after it will be correct, too. However if that is not true:

Check to see if the fetches that are correct have a different number of wait states than those that are not correct. If they do:

- Is the additional setup time for the READY# line causing problems in your target system circuitry? If it is, you may need to change the mode
of your target system from 'assert until wait state needed' to 'deassert until no wait state needed'. This is not typically necessary, but it is worth considering.

- Check that the additional delay for ADS is not causing problems in your target system circuitry. If it is causing problems, you may need to have your target system add a wait state. Refer to the section titled, "Timing specifications comparing the emulator with the 80386DX," and to Chapter 9, "Specifications and Characteristics," for detailed timing information.

- Check CLK generation (from the falling edge of RESET). If it is not correct, invert it.

- Check that your data meets the additional setup time required by the emulator. If it does not, you may need to add a wait state.

☐ Check to see if there is some pattern to the 'bad' read states. For example, see if there are HOLD states just before or after the bad reads? This might indicate more places for you to look for timing problems.

**If you cannot write/read memory (or I/O) correctly**

☐ If data fetches work but memory reads or writes, and I/O cycles do not occur normally, you may have a timing problem due to different decoding of those cycles in your target system. Check the items listed in the paragraph titled, "If the data fetched after the first address is not correct," above.

**If the program runs correctly for a while and then dies**

*(assuming that it does not die when the processor is plugged in)*

Read the status in the "Status" window. Then continue with the paragraph appropriate for the status shown, indicated in the following table.

<table>
<thead>
<tr>
<th>If the status window shows:</th>
<th>Begin with paragraph titled:</th>
</tr>
</thead>
<tbody>
<tr>
<td>HALTED</td>
<td>Program halts, no monitor</td>
</tr>
<tr>
<td>SHUTDOWN</td>
<td>Program shuts down, no monitor</td>
</tr>
<tr>
<td>any other status indication</td>
<td>Program dies, no monitor</td>
</tr>
</tbody>
</table>
Program halts, no intrusion

The only way a program can halt is to execute the hlt opcode. To observe where hlt is being executed, bring up the source window. If no source lines appear, use the window-specific menu; choose Display→Mixed Mode (ALT, -, D, M).

The source window will show the address of the opcode. Check your map file and listings to determine whether or not the code should have been executed. If there is no code in the source window (or there is no hlt at that address), then the target system is having problems fetching data; check the items listed under the paragraph titled, "If the data fetched after the first address is not correct."

- If the hlt instruction is in your code, determine if that code should have been executed (for example, perhaps you forgot to hook up an interface cable within your target system before you powered up the system).
- If the hlt instruction is not in your code, try replacing the emulator with the target processor.
- If the problem does not occur when using the target processor, the emulator is probably having problems reading I/O or memory. In this case, go to the paragraph titled, "If you cannot write/read memory (or I/O) correctly," earlier in this chapter.

If you have similar problems when the target processor is plugged in, see if the problem could be a programming problem. Did the target system act this way before the emulator was plugged in? Were any connections unplugged when inserting the emulator?

If the answer to the above questions is "no", you may have a problem with excessive ringing on the lines the emulator drives; they may have driven your circuitry into latchup (which can occur if the ringing rises above VCC=+0.7V for 5 ns or more). With the emulator plugged in again, use the oscilloscope to check for ringing on the address, data, and control lines. You may need to rethink your physical connection to the emulator. Refer to the paragraph titled, "Make physical connection between emulator and target system," earlier in this chapter. If you cannot change the physical connection to the emulator, try adding some small capacitors on the lines that ring too much.
Program shuts down, no intrusion

The 80386 enters "shutdown" mode when it tries to execute the "double fault" routine twice. Likely causes of this event include:

- reading bad data from the GDT or LDT.
- getting bad vectors from an interrupt.
- reading bad data from the IDT.

To determine the cause of the problem, set the analyzer up to trace until shutdown occurs, as follows:

1. Choose the Trace→Trigger Store... (ALT, T, T) command.
2. In the Trigger Store Trace dialog box, select trigger end, and choose the OK button.
3. Choose Trace→Until Halt (ALT, T, U).
4. Turn off power to your target system and then turn it on again, and wait until the shutdown occurs.
5. When shutdown occurs, choose Trace→Halt (ALT, T, H).

Display the trace list and view the states leading up to the shutdown (state -1). If the trace list indicates an interrupt vector was fetched a few states prior to the shutdown, check to see if the vector was correct. If the vector was not correct, there may be a timing problem related to decoding and responding to the interrupt acknowledge cycle. If the vector was correct, there is likely a problem reading memory; refer to the paragraph titled, "If you cannot write/read memory (or I/O) correctly," earlier in this chapter.

Program dies, no intrusion

Before you spend a lot of time characterizing the problem, check your physical connection, as discussed in the paragraph titled, "Make physical connection between emulator and target system," earlier in this chapter. If you are using the best possible connection, check the timing as directed in the paragraph titled, "If the data fetched after the first address is not correct," earlier in this chapter.

If you have done all of the checks listed above, you will need to see what happens at the point where the program stops operating correctly. Generally, you will find a timing problem, but it may be very difficult to find.
Using Emulation Memory with no Intrusion

This step in the procedure uses some emulation memory to verify that the target system works with emulation memory.

Specifying a CLK2 speed

If you are not using 4-Mbyte SIMMs, you can skip this step (leave the emulation configuration option at the default "CLK2 frequency > 60 MHz").

If you have one or two 4-Mbyte SIMMs installed on the emulator probe, you must determine if your CLK2 speed is above 60 MHz. If it is, then accesses to the 4-Mbyte SIMM(s) will require at least one wait state, which the emulator will enforce. If you do not choose the "Use target RDY" option of the emulation configuration, any access to the memory space mapped to 4-Mbyte SIMMs will get exactly one wait state. If you choose the "Use target RDY" option, the READY# signal from the target system will be ignored for the first state, and then passed through to the processor after that.

Note

If your target system asserts READY# for only the first cycle of an access to a 4-Mbyte SIMM, the emulator will hang on accesses. Your target system must assert READY# either for any one cycle after the first, or must assert READY# for the first two cycles (at least).

Refer to the timing diagrams. The timing diagrams illustrate timing conditions when using the 4-Mbyte SIMMs with CLK2 greater than 60 MHz. If your timing conditions match any of the first three timing diagrams after you choose "Use target RDY", you should have no timing problem with the READY# line. If your timing conditions are best represented by the fourth timing diagram, you will have timing problems with the READY# line. In the fourth case, you will need to modify your target circuitry to obtain timing conditions shown in one of the first three timing diagrams.
Chapter 4: Plugging the Emulator into a Target System

Using Emulation Memory with no Intrusion
Chapter 4: Plugging the Emulator into a Target System

Using Emulation Memory with no Intrusion

Mapping the memory

1 Determine an address space that can be replaced with emulation memory.

2 Choose Settings→Emulator Config→Memory Map... (ALT, S, E, M).

3 Within the memory map, replace system memory with emulation memory. If the target system would normally generate the READY# signal for the address space, select the "Use target RDY:" option so that any state machines in your target system will remain synchronized with the processor.

If you are using paging, note that the address range of the memory is a physical address, not linear.

Loading the memory

1 Choose Execution→Reset (ALT, E, E).

2 Power up your target system.

3 Choose Execution→Break (ALT, E, B).

4 At this point you can download code to the emulation memory with the File→Load Object... (ALT, F, L) command. (This assumes you are receiving the CLK2 signal, see above.)

The emulator is placed in the reset state before the target system is powered up to prevent the target system from attempting to run immediately when it is power up.

If you are mapping emulation memory over addresses in target-system ROM, you must load the emulation memory with the ROM code.
Run your program with emulation memory

1 Turn off power to your target system.

2 Choose Execution→Run... (ALT, E, R).

3 Choose Trace→Until Halt (ALT, T, U).

4 Turn on power to your target system.

This step runs the target program from emulation memory. The analyzer traces target system execution until you halt the trace.

If the target system executes with no problems, go to the paragraph titled, "Using the Background Monitor."

If the target system runs but its power-on self test indicates an error, one of the following is the likely cause of the problem:

• The self test failed because some of the memory address space which is normally found in dynamic memory was mapped to emulation memory, which is static memory. (In some target systems, if any portion of address space in a range residing in dynamic memory can be written to and read, the refresh system is not turned on. The address space in emulation memory could be written to and read so refresh was not turned on, failing to refresh the portion of the address space residing in dynamic memory.

• The self test failed because of a checksum error. This probably means that your loaded program has 'unprogrammed' bytes in it, and the checksum routine assumes these bytes will be 00's or ff's. If this is the case, set the emulation memory first to the appropriate value (all 00's or all ff's), and then reload your program and try again.

• If the target system halted, shutdown, or began executing in unknown address space, the problem is probably that you should have used the "Use target RDY" option when you mapped memory. Select the memory map and use the "Use target RDY" option for the emulation memory address space.
• If the status indication is "waiting", no READY# signal was generated (when you accessed emulation memory). You should not have used the "Use target RDY" option when you mapped this memory address space, or you are using 4-Mbyte SIMMs and your system did not have READY# true after the first cycle (refer to the paragraph titled, "Specifying a CLK2 speed," earlier in this chapter.)
Using the Background Monitor

If your target system does not need to service interrupts when you are in the monitor, you should use the background monitor (the default monitor) because it is easier to use. You use the monitor when:

- You use the Execution→Break command, or break into the background monitor as the result of executing a breakpoint.
- You are single-stepping code in your program.
- You configure real-time for "Monitor Intrusion→Allowed", and you are viewing a window that uses monitor routines to update its display content, such as the I/O, source, memory, or GDT window. If the content to be updated is mapped to dual-port emulation memory, the monitor is not needed to update it.

Emulation with the background monitor

1. Run your target system; then choose Execution→Break (ALT, E, B).

   Use the memory window to look at memory provided by your system. If some of the memory space that is to contain code contains all 0’s or all 1’s instead, you cannot use the background monitor (memory refresh activity has failed to occur, or some other hardware has reset your memory system).

2. If all memory content appears to be OK, choose Execution→Run (ALT, E, U).

   See if the target system runs OK. If it does, try Execution→Break and Execution→Run several times. You may find that your target system will tolerate not servicing interrupts only if you happen to break at certain locations in your code, but not at all locations. It is common to discover that your target system can safely break within certain interrupt routines, but no place else.
Using the Foreground Monitor

In order to use a foreground monitor, there are two items you must provide:
monitor address, and monitor selector. You can see these items in the dialog
box that appears when you choose Settings→Emulator
Config→Monitor...(ALT, S, E, O).

Monitor address

You need to provide a physical and linear address space (16 Kbytes) to
contain the monitor. It is OK if a self-test destroys the content of this
address space because prior to entering the monitor, the emulator checks it
for validity and reloads it, if necessary. If you place the monitor within the
lowest 1 Mbyte of address space (address between 0 and 0fffff), you can use
the foreground monitor while in real mode (prior to entering protected
mode). If the monitor is not located in the lowest 1 Mbyte of address space,
you can still break (etc.), but the background monitor will automatically be
used.

If you are not using paging, go to the paragraph titled, "Monitor Selector".

Considerations when using the foreground monitor and paging

The physical address and linear address must be identical. Furthermore,
there must be a valid page table (and therefore page directory) for the
associated linear addresses, but the page table entry does not need to be
valid. The emulator will update it prior to entering the monitor. Generally,
this means that you will need to find an unused physical address with an
identical linear address and ensure there is a valid page directory entry
pointing to an allocated page table for that linear address.
Monitor selector

The monitor selector is a selector in your GDT (Global Descriptor Table) that you are not using. Note that the monitor selector must be a multiple of 8 (ending in 0 or 8). You do not need to put any data into the GDT table; before entering the monitor, the emulator will update the table entries automatically to point to the monitor.

The best way to make room in your GDT is to rebuild your table with an empty selector. If you can do this, rebuild your table with an empty selector and go to the paragraph titled, "Executing the foreground monitor". If you cannot rebuild your table with an empty selector, proceed with the next paragraph.

Manually making room in the GDT

The objective of this step is to increase the size of the table by eight bytes. If the table is static, you can:

1 Map emulation memory over the GDT.

2 Copy the data using the Memory Window Utilities→Image (ALT, -, U, I) command.

3 The LGDT command references a "GDT pointer", containing the base of the GDT and the limit of the GDT. Use the Memory Window Utilities→Image (ALT, -, U, I) command to copy this into emulation memory as you did with the GDT itself, and then increase the limit by 8.

If the GDT is loaded in some other way, use this same idea (suitably modified) to increase the size of the table by eight bytes.
Executing the foreground monitor

At this point, both the target system and the emulator are configured appropriately. Simply use the emulator. When you are executing in the foreground monitor, interrupts will be serviced as if the program were running normally. If an interrupt routine takes a long time (or does not return), the status window will show "MONITOR INTERRUPTED BY TARGET."

In order to either trace your interrupt routines, or to avoid tracing your interrupt routines, refer to the paragraph titled, "Tracing Monitor Cycles" in the windows online help for the Real-Time C Debugger.
Dealing with Keep-Alive Circuitry by Customizing the Foreground Monitor

There are three types of "keep-alive" circuitry in common use (see below). Only one of these three types require modification of the foreground monitor:

**Bus-cycle monitor**

This type of keep-alive circuit simply verifies that bus cycles are occurring. Because the foreground monitor's bus cycles are visible to the target system, bus-cycle keep-alive circuits should be updated with no problem.

**Interrupt-response checking**

This type of keep-alive circuit generates an interrupt and verifies that the interrupt is serviced correctly. Because interrupts are serviced while in the foreground monitor, an interrupt-response keep-alive circuit should operate with no problem.

**Idle-loop detect**

This type of keep-alive circuit requires a specific memory or I/O address to be accessed in order to prevent the keep-alive circuit from resetting the processor. Because the code to access the watchdog address is not being executed, you will have to modify the monitor to prevent watchdog shutdown. There are two possible ways to deal with the problem: (1) turn off the keep-alive timer on entry to the monitor and re-enable it on exit from the monitor, or (2) have the monitor's idle-loop access the address.

The source code for the monitor is named "mon.asm". Look for the comments:

**USER_MODIFICATION**

within the source code to find the appropriate places to make modifications. Be sure to read the comments at the top of the mon.asm file before making any changes.
To disable and re-enable the keep-alive timer

1 Disable the timer after the FG_IDLE_ENTRY: label (there is a USER_MODIFICATION comment at this point).

2 Re-enable the timer prior to the "icebp" command prior to the RESTORE_CREGS: label. (There is another USER_MODIFICATION comment this point, too).

To access the keep-alive address within the idle loop

- This is done at the IDLE_LOOP: label in the mon.asm file.
Using Software Breakpoints and Execution Messages

Unless your target system needs to use the debug registers, you can easily use the software breakpoints. Simply enable them in the Hardware Configuration dialog box. Choose Settings→Emulator Config→Hardware... (ALT, S, E, H).

When software breakpoints are enabled, there is a longer delay from the release of RESET to initiation of the first cycle. If this delay causes problems, refer to the paragraph titled, "Start target system," earlier in this chapter. If your program attempts to modify the debug registers, the emulator will break into the monitor and inform you of the problem.

To use the execution messages, simply enable them in the Hardware Configuration dialog box, as accessed above. Use of the execution messages will also cause the first cycle after RESET to be delayed. In addition, whenever a jump occurs, the processor will appear to have an additional "idle" cycle. In reality, it is emitting the target address of the jump for the trace analyzer, but to the target system hardware, it merely looks like an idle state. This should not cause problems for your target system unless you have an extremely tight timing loop in your code.
Using the Reset Flying Lead

The i80386DX does not have a 'reset out' line. This is unfortunate because typical target systems have hardware that must be reset whenever the processor is reset in order for the power up sequence to complete correctly. Although you can reset your target system by turning its power off and then on again, this procedure is inconvenient. A reset button installed in your target system can be another way to reset the system. It is most convenient, however, to simply choose Execution→Reset (ALT, E, E) and have the i80386DX and any associated target system hardware all reset at the same time.

In order to use this command and have your target system reset at the same time that the emulation processor resets, you must attach the "Reset Flying Lead" to your target system.

Reset switch method

If your system has a reset button, find out if it grounds a signal that is pulled up by a resistor. If it does, simply attach the Reset Flying Lead to the pull-up resistor as shown in the diagram.
Power-on circuit method

If the power-on reset circuit has a simple resistor-capacitor delay, connect the Reset Flying Lead to the capacitor as shown:
General Information about the Emulator

Timing specifications comparing the emulator with the 80386DX

Refer to Chapter 9, "Specifications and Characteristics," for a listing of detailed information that compares each emulator signal with its same signal in the i80386DX microprocessor.

Equivalent circuits interfacing target with processor

The following diagram will help you understand the loading and timing differences between the processor and the emulator.
Chapter 4: Plugging the Emulator into a Target System

General Information about the Emulator

- 80386DX on Emulator
- 1-3ns, 10pF
- 1-5ns, 10pF, 100uA
- 2 CLK2 cycles, 8pF, 100uA
- 2-10ns, 15pF, 10uA
- READY#, NA#, BS16#
- 100uA, 8pF
- 10 pF, 100uA

- Socket on Target System
- CLK2
- 1-5ns, 10pF, 100uA
- 2 CLK2 cycles, 8pF, 100uA
- 2-10ns, 15pF, 10uA
- READY#, NA#, BS16#
- 100uA, 8pF
- 10 pF, 100uA
- NMI, INTR
- ERROR#, BUSY#, PPEREQ
- 15pF, 10uA
- 10pF, 100uA
- HOLD
- 1-4ns, 10pF, 100uA in, 32mA Drive
- D31-0
- 1-5ns, 32mA
- ADS#, HLDA
- W/R#, D/C#, M/IO#
- BE3-0, A31-2, LOCK#
Part 2

Service
Installing/Updating HP 64700 Firmware
Installing/Updating HP 64700 Firmware

You need to update the emulator firmware if:

• You ordered the emulator probe and the HP 64748C emulation control card separately.
• You are using an HP 64748C that has been previously used with a different emulator probe.
• You are upgrading to a newer version of the emulator.
• You received a firmware update disk from HP.

If you ordered the emulator probe and the HP 64748C emulation control card together, you can ignore this chapter. The control card already contains the correct firmware for the emulator probe.

This chapter shows you how to install or update HP 64700 firmware.

**Note**

If you are using an HP 64700A, it must contain the optional Flash EPROM memory card before you can install or update HP 64700 system firmware. Flash EPROM memory is standard in the HP 64700B card cage.

The firmware, and the program that downloads it into the HP 64700, are included with the debugger on floppy disks labeled HP64700 EMUL/ANLY FIRMWARE.

The steps to install or update HP 64700 firmware are:

• Step 1. Connect the HP 64700 card cage to your PC.
• Step 2. Install the firmware update utility.
• Step 3. Run PROGFLASH to update HP 64700 firmware.
• Step 4. Verify emulator performance.

The above steps are described in detail on the following pages.
Step 1. Connect the HP 64700 card cage to your PC

1 Set the COMM CONFIG switches for RS-232C communication. To do this, locate the DIP switches on the HP 64700 rear panel, and set them as shown below.

You may wish to make a note of the COMM CONFIG switch settings before you change them. That way, you can restore the switch settings when you finish updating the firmware.

Switches 12 and 13 are set to 1 and 0, respectively. This sets the RTS/CTS hardware handshake, which is needed to make sure all characters are processed.

Switches 1, 2, and 3 are set to 0. This sets the baud rate to 9600.

Switch 16 is the LAN/RS-232 switch.

The switch settings are read during the HP 64700 power up routine.

2 Connect an RS-232C modem cable from the PC to the HP 64700 (for example, an HP 24542M 9-pin to 25-pin cable or an HP 13242N 25-pin to 25-pin cable).

You can also use an RS-232C printer cable, but if you do, you must set COMM CONFIG switch 4 to 1.
Insert the 25-pin male connector of the cable into PORT A on the HP 64700 rear panel. See which COM port the cable is connected to on your PC. Some PCs label COM ports as Serial ports (e.g., COM1 may be labeled Serial A).

3 Turn ON power to the HP 64700.

The power switch is located on the lower left-hand corner of the front panel. The power lamp at the lower right-hand corner of the front panel will light.

4 Start MS Windows in the 386 enhanced mode.

To ensure your PC is running in the 386 Enhanced Mode, double-click the PIF Editor in the Main or Accessories window. Choose the Mode pulldown in the PIF Editor menu bar. A check mark should be beside "386 Enhanced" in the Mode pulldown.

5 Verify RS-232 communication by using the Terminal program that is found in the Windows "Accessories" group box.

Double-click on the "Terminal" icon to open the Terminal window. Then, choose the Settings→Communications... (ALT, S, C) command, and select: 9600 Baud Rate, 8 Data Bits, 1 Stop Bit, Parity None, Hardware Flow Control, and the PC's RS-232 interface connector to which the RS-232 cable is attached (example: COM1). Choose the OK button.

You should now be able to press the Enter key in the Terminal window to see the HP 64700's Terminal Interface prompt (for example, p>, R>, M>, U>). A -> prompt indicates the present firmware does not match the emulator probe, or there is no probe connected. If you see a prompt, you have verified RS-232 communication. If you do not see a prompt, refer to "If you have RS-232 connection problems" in Chapter 6.

6 Exit the Terminal window.
Step 2. Install the firmware update utility

The firmware update utility and emulation and analysis firmware require about 1.5 Mbytes of disk space.

1. Start MS Windows in the 386 enhanced mode.

2. Insert HP64700 EMUL/ANLY FIRMWARE Disk 1 of 2 into floppy disk drive A or B.

3. Choose the File→Run... (ALT, F, R) command in the Windows Program Manager. Enter "a:setup" (or "b:setup" if you installed the floppy disk into drive B) in the Command Line text box.

Then, choose the OK button. Follow the instructions on the screen.

You will be asked to enter the installation path. The default installation path is C:\HP64700.
Wait until the Setup Exit Message dialog box appears. This indicates installation of the firmware update utility is complete.

4 After completing the installation, use the editor of your choice to edit the C:\CONFIG.SYS file to include these lines:

```
BREAK=ON
FILES=20
```

BREAK=ON allows the system to check for two break conditions: CTRL+Break, and CTRL+c.

FILES=20 allows 20 files to be accessed concurrently. This number must be at LEAST 20 to allow the firmware update utility to operate properly.

5 If you installed the files in a path other than the default (C:\HP64700), edit the C:\AUTOEXEC.BAT and C:\HP64700\BIN\FLASH.BAT files, as follows:

- Edit AUTOEXEC.BAT to set the HP64700 and HPTABLES environment variables. For example:
  ```
  SET HP64700=C:\<installation_path>
  SET HPTABLES=C:\<installation_path>\TABLES
  ```

- Edit FLASH.BAT to identify the location of PROGFLAS.EXE. For example:
  ```
  C:\<installation_path>\PROGFLAS.EXE
  ```

6 The default <installation_path>\TABLES\64700TAB file contains entries to establish communications connections for COM1 and COM2. The content of this file is:

```
EMUL_COM1 unknown COM1 OFF 9600 NONE ON 1 8
EMUL_COM2 unknown COM2 OFF 9600 NONE ON 1 8
```

7 You can edit this file to identify your emulator, if desired:

```
EMUL_COM1 i80386 COM1 OFF 9600 NONE ON 1 8
EMUL_COM2 unknown COM2 OFF 9600 NONE ON 1 8
```
If you are using the COM3 or COM4 port to update your firmware, you need to edit the `<installation_path>`\TABLES\64700TAB file. Either add another line or modify one of the existing lines. For example:

```
EMUL_COM3 180386 COM3 OFF 9600 NONE ON 1 8
EMUL_COM4 unknown COM4 OFF 9600 NONE ON 1 8
```

Exit Windows and reboot your PC to activate the changes made to the CONFIG.SYS and AUTOEXEC.BAT files (CTRL+ALT+DEL). Installation of the firmware update utility is now complete.

---

**Step 3. Run PROGFLASH to update HP 64700 firmware**

1. Start MS Windows in the 386 enhanced mode.

2. If the "HP 64700 Firmware Utility" group box is not opened, open it by double-clicking the icon.

3. Double-click the "PROGFLASH" icon. (You can abort the PROGFLASH command by pressing CTRL+c.)

4. Enter the number that identifies the emulator you want to update. For example, enter "1" if you want to update the emulator identified by the line, "1 emul_com1 my_emul."

5. Enter the number that identifies the product whose firmware you wish to update. For example, if the HP 64789A product is listed as number 13, enter "13".

```
Product
1  64782
2  E3490
13  64789
```
6 Enter "y" to enable progress messages.

The PROGFLASH program downloads code from files on the host computer into Flash EPROM memory in the HP 64700. During this download, you will see messages like:

Rebooting HP64700...with init -r

Downloading flash programming code: '/hp64700/lib/npf.X'
Checking Hardware id code...
Erasing Flash ROM
Downloading ROM code: '/hp64700/update/64789.X'
Code start 280000H
Code size 29ABAH
Finishing up...

Rebooting HP64700...
Flash programming SUCCEEDED

You can display firmware version information and verify the update by choosing the Help→About Debugger/Emulator... (ALT, H, D) command in the Real-Time C Debugger.

---

Step 4. Verify emulator performance

- Perform the procedure titled, "To verify the performance of the emulator" in Chapter 6 of this manual.
Solving Problems

What to do when the emulator does not behave as expected.
Sometime during your use of the emulator, you will encounter a problem that is not adequately explained by an error message or obvious target system symptoms. This chapter explains how to solve some of these problems.
To verify the performance of the emulator

1. If you have a special configuration or session in progress, save it now. This procedure will cause your session to be lost.

2. Turn off power to the HP 64700 Card Cage.

3. Plug the emulator probe into the Demo Board. (See Chapter 3.)

4. Connect Demo Board power cable from the Demo Board to the HP 64700 Card Cage front panel. (See page 19.)

5. Turn on power to the HP 64700 Card Cage.

6. Establish communication with the emulator from your host or ASCII terminal and obtain a prompt (such as R>). (See Chapter 2.)

7. Enter: pv 1 <return>

There are different hardware system configurations for the HP 64700 Series system. For information on hardware configurations, refer to the HP 64700 Installation/Service manual.
Chapter 6: Solving Problems

To verify the performance of the emulator

Examples

If you are using a LAN, you can use the telnet capability with the Terminal Interface:

1. From your host computer enter the command:
   `telnet <emulator_name>`.

2. Now enter the command: `pv 1`

Note: the HP 64700 telnet capability is not supported by Hewlett-Packard.

After about a minute, the emulator should display a list of tests which were performed, and whether they were passed or failed.

If you have an emulation failure, you can replace the assembly that failed. Refer to the list of replacable parts in Chapter 7. Contact your local Hewlett-Packard representative. Refer to the list of Sales Offices in the Support Services book supplied with this manual.

When your performance verification test is complete, use the keyboard <CTRL>d keys to end the emulation session.

To verify installation of memory modules in the deep analyzer card or in the emulation probe, type the ver command as follows:

M>ver

The emulator should display a message similar to the following:

Copyright (c) Hewlett-Packard Co. 1987
All Rights Reserved. Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under copyright laws.

HP64700 Series Emulation System
  Version:   A.04.00 22Oct92
HP64789C Intel 80386 Emulator
  Version:   A.00.00 01Jun94 Lab Proto
  Control:   HP64748C Emulation Control Board
  Speed:     25.1 MHz
  Memory:    256 Kbytes
    Bank 0:  HP64172A (20ns) 256 Kbyte Memory Module
HP64740 Emulation Analyzer
  Version:   A.02.02 13Mar91
HP64701A LAN Interface
  Version:   A.00.04 21Oct91

92
What is pv doing to the Emulator?

The performance verification procedures provide a thorough check of the functionality of all of the products installed in the HP 64700 Card Cage. The following is an example Test Suite for an HP 64700 Card Cage containing an HP 64789A Emulator. To see the exact Test Suite for the HP 64789A Emulator and associated modules in your HP 64700 Card Cage, enter the command: pv -l.

Tests available in Emulator Subsystem:

- test # 1 (ABG 68000 RAM)
- test # 2 (ABG Type Map)
- test # 3 (ABG DeMMU Map)
- test # 4 (Low DMMU RAM)
- test # 5 (up DMMU RAM)
- test # 6 (68000 side RAM)
- test # 7 (iFX780 JTAG id)
- test # 8 (Host DP RAM)
- test # 9 (Noclk2 Test)
- test #10 (386 access dp)
- test #11 (386 self test)
- test #12 (Reset to bg mon)
- test #13 (hw reg test)
- test #14 (Reset to pgm)
- test #15 (Check rst lead)
- test #16 (Byte enables)
- test #17 (Reset to fg mon)
- test #18 (DP interaction)
- test #19 (Mon Transition)
- test #20 (Proc Version)
- test #21 (Break Detection)
- test #22 (Dual Port RAM)
- test #23 (Emul Mem Bank 0)
- test #24 (Emul Mem Bank 1)
- test #25 (Exec Emul Mem)
- test #26 (W/S gen)
- test #27 (ERY_L gen)
- test #28 (NMI)
- test #29 (INTR)
- test #30 (Targ Ready)
- test #31 (NA# Reset)
- test #32 (Analysis Intrfc)
- test #33 (Analysis NA#)
- test #34 (Addr/Data Test)
- test #35 (M/IO, BE Tests)
- test #36 (BS16 Test)
- test #37 (Hold Test)
- test #38 (Lock Test)
- test #39 (Reset Test)
- test #40 (Display Test)
- test #41 (CMB)
Chapter 6: Solving Problems

To ensure software compatibility

Troubleshooting

The test results for all of these modules are indicated by a simple PASS/FAIL message. The PASS message gives a high level of confidence that all major functions and signals are operating because the PV test includes a loopback test that performs read and write tests to the demo board. The demo board also stimulates inputs to the emulator.

A FAIL message indicates that one or more of the tested functions is NOT working. In this event, call your local Hewlett-Packard field representative.

To ensure software compatibility

There are various sets of firmware resident in the assemblies contained in the HP 64700 Card Cage. It is important to ensure that all the versions are compatible among the products you have installed. You can determine which versions of firmware you have by entering the terminal interface ver command.

There are at least four assemblies that have separate firmware in the HP 64700 Card Cage. These assemblies are:

- Host Controller card
- Emulator card
- Analyzer card
- Local Area Network card

If you purchased a complete Emulation/Analysis System from HP, you can be assured that all the products contained in the HP 64700 Card Cage contain compatible firmware at the time of sale. Software compatibility problems can occur when you swap the host controller card, emulator card, analyzer card, or local area network (LAN) card from one HP 64700 Card Cage to another, or from a recently purchased subassembly.

For example, you might purchase only the emulator subassembly (Emulation Control Card, Probe, and interconnecting ribbon cable) and replace the original emulator subassembly with the one you just purchased. In this case, the host controller may contain a version of firmware that is older than required to operate the new emulator; hence, compatibility problems can be
caused by a newer emulator. All emulators will work with the latest software versions. The emulator software will warn you of incompatible software.

This emulator and the LAN card in the HP 64700B card cage have Flash EPROMs that can be updated with current versions of firmware. Other products (assemblies) that do not use the Flash EPROM technology can also be updated with the latest firmware by using the Flash EPROM in the HP 64700B card cage.

If you are using an HP 64700A card cage, you can obtain an optional LAN card and an optional Flash EPROM card from your local Hewlett-Packard representative. The optional Flash EPROM card can be inserted in an available slot in the HP 64700A card cage to override old versions of firmware in products with conventional EPROMs. The host controller in the HP 64700A card cage is already programmed to look for a Flash EPROM card if one is installed. To obtain an optional LAN card and/or optional Flash EPROM card, refer to the list of HP Sales Offices in the Support Services book supplied with this manual.

The software for the HP 64700 i80386 Real-Time C Debugger for PCs is shipped on two floppy disks that also contain the latest versions of firmware for the host controller card, analyzer card, LAN card, and a program called progflash.

When you load all your new versions of software onto your host computer, you are ready to load the new version of firmware from your host computer to the assemblies in the HP 64700 Card Cage. To load the new firmware, follow the procedures described in Chapter 5, "Installing/Updating HP 64700 Firmware."
To display the emulator status

The emulator status is displayed on a status line in the graphical interface. If you need to display the emulator status using the built-in Terminal Interface:

- Display the emulator status by typing: `es`

  The emulation prompts tell you most information about the emulator's status: whether the emulator is reset, running a user program, or running in monitor. If you need more information than is given by the prompt, you can use the `es` command.

Example

```
R> es
80386--Emulation reset
R>
```

To check the version of the terminal interface software

Type `ver` to display the version numbers of the Terminal Interface system software and emulator software.

The i80386 emulator firmware must be used with the correct version of the emulation system and emulation analyzer firmware. See the paragraph titled, "To ensure software compatibility" earlier in this chapter for more information.
If the emulator appears to be malfunctioning

☐ Check to make sure that the cables connecting the Emulation Control Board to the Emulation Probe are connected correctly.

☐ Run the performance verification procedure as described in this chapter. If the emulator fails this test, contact your Hewlett-Packard representative.

☐ If the emulator passes the performance verification procedure, look for other reasons for the problem. Performance Verification is a thorough test, but it cannot find every hardware failure in the emulator. It is a good indication that the emulator is functioning correctly, but if you are still convinced the emulator is malfunctioning, contact your local Hewlett-Packard representative.

If you suspect the emulator is broken

☐ Run the Performance Verification procedure as described in the first paragraph of this chapter. If either the emulator or analyzer fail the performance verification, check the installation of those modules. If the installation is correct, contact your local HP Sales and Service office for assistance.
If you have RS-232 connection problems

☐ Windows 3.1 only allows two active RS-232 connections at a time. To be warned when you violate this restriction, choose Always Warn in the Device Contention group box under 386 Enhanced in the Control Panel.

☐ Use the "Terminal" program (usually found in the Accessories windows program group) to set up the "Communications..." settings as follows:

- Baud Rate: 9600
- Data Bits: 8
- Parity: None
- Flow Control: Hardware
- Stop Bits: 1

When you are connected, press the Enter key. You should get a prompt back. If nothing echos back, check the switch settings on the back of the emulator:

Switches 1 thru 3 set the baud rate as follows:

<table>
<thead>
<tr>
<th>S1</th>
<th>S2</th>
<th>S3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Switches 12 and 13 must be set to 1 and 0, respectively. This sets the RTS/CTS hardware handshake which is needed to make sure all characters are processed.

All other switches should be in the "0" position, especially switch 16 on the HP 64700 (which selects LAN/Serial interface).

Remember that if you change any of the switch positions, you must turn OFF power to the HP 64700 and turn it ON again before the changes will take effect.

☐ If the switches are in the correct position and you still do not get a prompt when you press return, check the following:

- Turn OFF power to the HP 64700 and then turn it ON again. Press return to see if you get a prompt.
Check to make sure the RS-232 cable is connected to the correct port on your PC, and that the cable is appropriate for connecting the PC to a DCE device. If the cable is intended to connect the PC to a DTE device, set switch 4 to "1" (which makes the emulator a DTE device), turn OFF power to the HP 64700, turn power ON, and try again.

Check to make sure your RS-232 cable has the RTS, CTS, DSR, DCD, and DTR pins supported. If your PC RS-232 connection is a 9-pin male connection, HP cable number 24542M will work (set switch 4 to 0 if you use this cable). If your PC has a 25-pin RS232 connector, HPO cable number 13242N will work (set switch 4 to 0).

Always turn ON the HP 64700 before attempting to connect via RS-232. When using certain RS-232 cards, connecting to an RS-232 port where the HP 64700 is turned OFF (or not connected) will halt the PC. The only way to restore operation is to reboot the PC.

If the PC fails to connect to the HP 64700, or connects but soon reports over-run errors or times out, check the following:

- The serial interface in your PC may be insufficiently buffered. Use serial interface cards that include 16550AF UARTs (or better). To see which UART is used in your serial interface card:
  1. Enter the DOS command, "MSD".
  2. Within the window that appears, click on "COM Ports...".
  3. Within the COM Ports window, look at the entry beside "UART Chip Used."
- Turn off all unnecessary TSR's and other applications to allow the processor to more frequently service the serial interface.

If emulation memory behavior is erratic

Ensure that you have answered the configuration question correctly for the memory modules in use. If you have 4-Mbyte SIMM modules installed on the emulation probe, check CLK2. If your system uses a CLK2 speed greater than 60 MHz, read "Specifying a CLK2 speed" in Chapter 4, "Plugging the Emulator into a Target System."
If you're having problems with DMA

- Check to make sure that your external DMA process doesn’t access memory ranges mapped to emulation RAM (eram) or emulation ROM (erom). External DMA to emulation memory resources is not supported.

If the analyzer won’t trigger

- The processor fetches instructions in multiples of four. For example, if an instruction starts at address 1001H, the processor fetches it from address 1000H. Make sure you use trigger addresses that are multiples of four (addresses ending in 0, 4, 8, or C) when specifying instruction-fetch addresses in your trigger specifications.

If the analyzer triggers on a program address when it should not

- Check to see if the analyzer is triggering on an instruction prefetch. The analyzer cannot distinguish between prefetch and execution because the processor does not provide that information. For a detailed description of the problem and its solution, refer to the subject titled “Understanding 80386 analysis” in the online help screens part of the i80386 Emulator product.

- Try to pad the program code with NOP instructions to move the trigger address away from the other code so that it won’t be prefetched until it is time to trigger.

- You may be able to insert a write instruction to a meaningless variable in your code immediately following the trigger address. Then you can trigger on a write to the address of the variable. Write transactions never appear in instruction prefetches.
If you see unexplained states in the trace list

☐ Check to see that the sequence, storage, and trigger specifications are set up to exclude the states you don’t need.

☐ If you are using the built-in terminal interface, try using the `tl <instruction_state> <operand_state>` command to inform the disassembler which operand state belongs with the named instruction state.

☐ If you are using the built-in terminal interface, try using the `-o <#>` option to the `tl` command to begin disassembly from the low word of the starting state, instead of the high word.

☐ Check to see if some of the program in the range covered by the trace might have executed from internal processor RAM memory. If so, these cycles won’t appear in the trace list, which will confuse the disassembler. Use the `show cycles` feature of the processor to make internal RAM cycles visible to the analyzer. Obtain the show cycles feature by setting the two least-significant bits in the third byte of register SIM_MCR to "11".

If you see exclamation marks "!" in count columns of the trace lists

☐ This is a normal condition. It indicates the counter overflowed (began again at 0) before the present state was captured. The exclamation mark warns you that the counter value may not be accurate because the analyzer is unable to determine how many times the counter overflowed between the preceding state and the state where the exclamation mark is shown.

If you were to scroll through a trace list of the entire trace memory in relative count mode, a "!" would be seen beside the first state after each occurrence of counter overflow (each 22.9 minutes). If you were to scroll through the entire trace memory in absolute count, the "!" would be seen beside every state after the first occurrence of counter overflow.
If you see negative time or state counts in trace lists

If counter overflow occurs during a trace measurement, you may see a count of negative time or negative states in trace lists using the absolute time count mode. This indicates that the counter value stored with the trigger state was greater than the counter value stored with the present state. In absolute time counts, negative times will continue to be seen until a state is captured whose counter value is greater than the trigger state counter value. In relative time counts, the counter value is corrected so no negative time is seen.

If you do not see the counter overflow indication "!" where you expected to see it in a trace list

This may be a normal indication. If you scroll through a reduced portion of the trace memory, one that contains no counter overflow, no counter overflow indication will be seen, even if counter overflow occurred before the line range you specified in your display/store/copy command. The routine that reads trace memory to compose a trace list only reads the portion of the trace memory you specify in your display/store/copy command.

If the performance verification reports massive pv failures

Check to make sure mapper chip U84 on Emulation Control Card Subassembly HP 64748C is installed properly in its socket.
Parts List
Parts List

Part numbers for the B3637 floppies

The floppies supplied with this product contain the Real-Time C Debugger software and the HP 64789A firmware, along with firmware for the host controller card, analyzer card, LAN card, and the progflash routine used for updating product firmware in HP 64700 Card Cages. The part numbers for these floppies change each time a change is made to any of the software or firmware products on the floppies. If you need new floppies for your B3637 emulator, order the latest HP64700 EMUL/ANLY FIRMWARE floppies, not necessarily the part numbers shown in this Parts List.

What is an exchange part?

Exchange parts are shown on the parts list. A defective part can be returned to HP for repair in exchange for a rebuilt part.

Probe (exchange)

To replace the Probe on the exchange program, you must remove certain parts, and return only that part considered an exchange part. When returning the Probe, you must remove the:

- cable assembly.
- top and bottom plastic covers.
- SRAM modules.
- demo board.
- reset flying lead.

Emulation Control Card (exchange)

To replace the Emulation Control Card on the exchange program, you must remove certain parts, and return only that part considered an exchange part. When returning the Emulation Control Card, you must remove the:

- ribbon cable that connects the Emulation Control Card to the analyzer card.
- cable assembly.
- egress panel.
### Main Assembly

<table>
<thead>
<tr>
<th>Component Part</th>
<th>New</th>
<th>Exchange</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 64789A Probe and Demo Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP64700 EMUL/ANLY Firmware (1 of 2)</td>
<td>64700-17535</td>
<td></td>
</tr>
<tr>
<td>HP64700 EMUL/ANLY Firmware (2 of 2)</td>
<td>64700-17536</td>
<td></td>
</tr>
<tr>
<td>i80386 Probe Board Assy for HP 64789A</td>
<td>64789-66503</td>
<td>64789-69503</td>
</tr>
<tr>
<td>(Order the following parts separately:)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Top Plastic Cover</td>
<td>64783-04101</td>
<td></td>
</tr>
<tr>
<td>Bottom Plastic Cover</td>
<td>64783-04102</td>
<td></td>
</tr>
<tr>
<td>Plastic Rivets Kit (rivets and washers)</td>
<td>64748-68700</td>
<td></td>
</tr>
<tr>
<td>PGA Pin Protector, plastic</td>
<td>5181-0206</td>
<td></td>
</tr>
<tr>
<td>Cable, Reset Flying Lead</td>
<td>64762-61602</td>
<td></td>
</tr>
<tr>
<td>Male header, male/male double header</td>
<td>1200-1827</td>
<td></td>
</tr>
<tr>
<td>PGA Pin protector socket, male/female</td>
<td>1200-1635</td>
<td></td>
</tr>
<tr>
<td>Fan Assembly</td>
<td>3160-0825</td>
<td></td>
</tr>
<tr>
<td>i80386 Emulator Product Refurbished</td>
<td>64789A #8ZE</td>
<td></td>
</tr>
<tr>
<td>Demo Board for i80386</td>
<td>64789-66504</td>
<td></td>
</tr>
<tr>
<td>(Order the following part separately:)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>External +5V Power Cable</td>
<td>5181-0201</td>
<td></td>
</tr>
<tr>
<td>Fuse 3A 250V</td>
<td>2110-0837</td>
<td></td>
</tr>
<tr>
<td>Flexible cable</td>
<td>E3426-60001</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 7: Parts List

<table>
<thead>
<tr>
<th>Component Part</th>
<th>New</th>
<th>Exchange</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 64748C Emulation Control Card Subassembly</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Egress Panel</td>
<td>64748-00205</td>
<td></td>
</tr>
<tr>
<td>Bracket (used with Egress Panel)</td>
<td>64748-01201</td>
<td></td>
</tr>
<tr>
<td>Spacer, Hex M3X6</td>
<td>0515-1146</td>
<td></td>
</tr>
<tr>
<td>Screw, Machine M3X8</td>
<td>0515-0372</td>
<td></td>
</tr>
<tr>
<td>Cable-100 36&quot;</td>
<td>64748-61601</td>
<td></td>
</tr>
<tr>
<td>Cable-100 37&quot;</td>
<td>64748-61602</td>
<td></td>
</tr>
<tr>
<td>Cable-100 38&quot;</td>
<td>64748-61603</td>
<td></td>
</tr>
<tr>
<td>Cable Clamp</td>
<td>64744-01201</td>
<td></td>
</tr>
<tr>
<td>Rubber Strip</td>
<td>64744-81001</td>
<td></td>
</tr>
<tr>
<td>Emulation Control Card (without external cable or egress panel)</td>
<td>64748-66515</td>
<td>64748-69515</td>
</tr>
<tr>
<td>Wrist strap</td>
<td>9300-1405</td>
<td></td>
</tr>
<tr>
<td>HP 64172A 256-Kbyte, 20-nS SRAM Module</td>
<td>64172A</td>
<td>64172-69501</td>
</tr>
<tr>
<td>HP 64172B 1-Mbyte, 20-nS SRAM Module</td>
<td>64172B</td>
<td>64172-69502</td>
</tr>
<tr>
<td>HP 64173A 4-Mbyte, 25-nS SRAM Module</td>
<td>64173A</td>
<td>64173-69501</td>
</tr>
<tr>
<td>HP 64794A Emulation-Bus Analyzer (deep) card</td>
<td>64794-66502</td>
<td>64794-69502</td>
</tr>
<tr>
<td>34-pin ribbon cable</td>
<td>64708-61601</td>
<td></td>
</tr>
<tr>
<td>Analyzer Card HP 64740 with 1K memory depth</td>
<td>64740-66526</td>
<td>64740-69526</td>
</tr>
<tr>
<td>34-pin ribbon cable</td>
<td>64708-61601</td>
<td></td>
</tr>
</tbody>
</table>
Part 3

Terminal Interface Reference
Using the Terminal Interface

An introduction to the emulator's built-in terminal interface.
The emulator has a built-in, host-independent Terminal Interface. The Terminal Interface provides all the commands you need to make emulation and analysis measurements. The interface includes tools for emulator initialization, command entry and recall, and command help.

-----------------------------

**When to Use the Terminal Interface**

Hewlett-Packard suggests that you control the emulator with a graphical interface on a PC host computer (page 115). You may need to use the Terminal Interface, however, for tasks such as:

- Troubleshooting emulator hardware.
- Troubleshooting the connection between the emulator and your host computer.
- Developing a custom interface (such as a debugger) for the emulator.
- Using the emulator when a PC is not available, but a terminal or terminal emulator is available.
- Using the emulator if you are already an expert user of the Terminal Interface and you do not need the improved ease of use of the graphical interfaces.
Learning About the Terminal Interface

You should be able to find most of what you need to know about the Terminal Interface commands from the on-line help.

To start the terminal interface

- To connect the emulator to a terminal or host computer, see Chapter 2.

- If the emulator is connected to a LAN, type the following command to log in to the emulator:

  C:> telnet <hostname>

  Where <hostname> is the name of the emulator. You could use the Internet Protocol (IP) address (or internet address) in place of the emulator name, if desired.

  **Note**

  The "telnet" capability of the HP64700 card cage is unsupported. It is provided at no cost. Hewlett-Packard makes no warranty on its quality or fitness for a particular purpose.

- If the emulator is connected to your host computer or terminal via a serial port, press <return> a few times and you should see an emulator prompt.

  The Terminal Interface is active when you connect a terminal or terminal emulator to the emulator via a serial or LAN connection.
Example

If the IP address of your emulator is 15.35.226.210, type:

C:> telnet 15.35.226.210

You should see messages similar to:

Trying...
Connected to 15.35.226.210
Escape character is '^]'

After you connect to the emulator, you should see a prompt similar to:

R>

To view a list of available commands

1 Display the main help menu by typing: help

The main help menu lists groups of commands.

2 Display the commands in one of the groups by typing help followed by the name of the command group.

You can see a list of all of the commands by typing help *. This list may be too long to fit on your terminal display.
Example

To display the main help menu, enter:

R> help

The emulator will list the command groups:

```
help - display help information
help <group> - print help for desired group
help -s <group> - print short help for desired group
help <command> - print help for desired command
help - print this help screen

--- VALID <group> NAMES ---
gram - system grammar
proc - processor specific grammar
sys - system commands
emul - emulation commands
trc - analyzer trace commands
* - all command groups
```

To display help information for the emulation command group, enter:

R> help emul

The emulator will list the emulation commands. They will be similar to the following:

```
emul - emulation commands

---------------------------------------------
b......break to monitor   cp.....copy memory   mo.....modes
bc......break condition   dump.....dump memory  r......run user code
bp......breakpoints      es......emulation status
 cf......configuration    info......config info  rst......reset
 cim......copy target image  io......input/output  rx......run at CMB execute
ck......check config     load.....load memory   s......step
 cmb......CMB interaction m......memory         ser......search memory
 cov......coverage        map.....memory mapper  sync......sync sim and ems
```

Chapter 8: Using the Terminal Interface

To view a list of available commands
To view help on individual commands

- To display help information for a particular command, type: **help <command_name>**

The emulator will display the command syntax, description, and examples.

**Examples**

To display help information for the processor step command, enter:

```
R> help s
```

The emulator will display:

```
s - step emulation processor

s <- step one from current PC
s <count> <- step <count> from current PC
s <count> $ <- step <count> from current PC
s <count> <addr> <- step <count> from <addr>
 s-q <count> <addr> <- step <count> from <addr>, quiet mode
 s-w <count> <addr> <- step <count> from <addr>, whisper mode
```

--- NOTES ---

STEPCOUNT MUST BE SPECIFIED IF ADDRESS IS SPECIFIED!
If <addr> is not specified, default is to step from current PC.
A <count> of 0 implies step forever.

---

To view help on command syntax

- Type: **help gram**
Graphical Interfaces

HP provides two interfaces for this emulator:

- The built-in Terminal Interface.
- A graphical interface for MS-Windows.

HP also provides other instruments and software tools for developing, debugging, and optimizing embedded systems.

**Note**

Ask your HP sales representative for more information about these interfaces. Other interfaces may also be available from HP.

**Why use a graphical interface?**

- Use your PC's windowing environment.
- Reduce many commands (such as setting breakpoints or stepping through source lines) to a single mouse-click.
- Show different kinds of information about your target system at the same time (for example, register contents, memory contents, and high-level source code) in separate windows on the display.
- Simplify emulator configuration by clearly displaying configuration options and their relationship to one another.
- Automate frequent tasks through menu selections, user-defined buttons in the button window, and command files.
- Work with compilers and assemblers to shorten the edit-compile-execute cycle.
Specifications and Characteristics
Processor compatibility

The HP 64789A Emulator supports Intel 80386DX microprocessors. The emulator plugs directly into a 132-pin PGA socket, and it can be plugged into a PQFP target system using optional accessories.

Electrical

Clock speed

The maximum clock speed of the emulator is 33 MHz with no wait states required for emulation or target memory.
The minimum clock speed required is 16 MHz.

Power Requirements

The Vcc range is 4.75V to 5.25V.
The current requirement from the target system is 500 mA in addition to the current requirements for the i80386DX (example: total of 800 mA, typical, when CLK2=66MHz).
All other power is supplied by the card cage.

Real and protected addressing modes

The emulator supports real and protected addressing modes.

Emulation memory

The emulator supports use of up to 8 Megabytes of emulation memory.
## HP 64789A maximum ratings

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Symbol</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply Voltage</td>
<td>V_{CC}</td>
<td>-0.3 to +5.5</td>
<td>V</td>
</tr>
<tr>
<td>Input Voltage</td>
<td>V_{in}</td>
<td>-0.5 to +5.5</td>
<td>V</td>
</tr>
<tr>
<td>Maximum Operating Ambient Temperature</td>
<td>T_{A}</td>
<td>45</td>
<td>°C</td>
</tr>
<tr>
<td>Minimum Operating Ambient Temperature</td>
<td>T_{A}</td>
<td>0</td>
<td>°C</td>
</tr>
<tr>
<td>Storage Temperature Range</td>
<td>T_{stg}</td>
<td>-40 to +70</td>
<td>°C</td>
</tr>
</tbody>
</table>
HP 64789A AC electrical specifications

*(Compares Intel 80386DX, 33-MHz Processor to Emulator)*

<table>
<thead>
<tr>
<th>Signal Symbol</th>
<th>Signal Parameter</th>
<th>80386DX</th>
<th>Emulator</th>
</tr>
</thead>
<tbody>
<tr>
<td>t1</td>
<td>CLK2 period</td>
<td>15</td>
<td>62.5</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t6</td>
<td>A2-A31 valid delay</td>
<td>4</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t7</td>
<td>A2-A31 Float Delay</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t8</td>
<td>BE0#-BE3#, LOCK# Valid Delay</td>
<td>4</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t9</td>
<td>BE0#-BE3#, LOCK# Float Delay</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t10</td>
<td>W/R#, M/IO#, D/C#, Valid Delay</td>
<td>4</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t10a</td>
<td>ADS# Valid Delay</td>
<td>4</td>
<td>14.5</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t11</td>
<td>W/R#, M/IO#, D/C#, ADS# Float Delay</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t12</td>
<td>D0-D31 Write Data Valid Delay</td>
<td>7</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t12a</td>
<td>D0-D31 Write Data Hold Time</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t13</td>
<td>D0-D31 Float Delay</td>
<td>4</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t14</td>
<td>HLDA Valid Delay</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t15</td>
<td>NA# Setup Time</td>
<td>5</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t16</td>
<td>NA# Hold Time</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t17</td>
<td>BS16# Setup Time</td>
<td>5</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t18</td>
<td>BS16# Hold Time</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t19</td>
<td>READY# Setup Time</td>
<td>7</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
<tr>
<td>t20</td>
<td>READY# Hold Time</td>
<td>4</td>
<td>-</td>
</tr>
</tbody>
</table>
## Signal Specifications

<table>
<thead>
<tr>
<th>Signal Symbol</th>
<th>Signal Parameter</th>
<th>80386DX</th>
<th>Emulator</th>
</tr>
</thead>
<tbody>
<tr>
<td>t21</td>
<td>D0-D31 Read Setup Time</td>
<td>5</td>
<td>9.6</td>
</tr>
<tr>
<td>t22</td>
<td>D0-D31 Read Hold Time</td>
<td>3</td>
<td>6.5</td>
</tr>
<tr>
<td>t23</td>
<td>HOLD Setup Time</td>
<td>11</td>
<td>9</td>
</tr>
<tr>
<td>t24</td>
<td>HOLD Hold Time</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>t25</td>
<td>RESET Setup Time</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>t26</td>
<td>RESET Hold Time</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>t27</td>
<td>NMI, INTR Setup Time</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>t28</td>
<td>NMI, INTR Hold Time</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>t29</td>
<td>PEREQ, ERROR#, BUSY# Setup Time</td>
<td>5</td>
<td>same</td>
</tr>
<tr>
<td>t30</td>
<td>PEREQ, ERROR#, BUSY# Hold Time</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>T2 Start to Read Data Valid (33 MHz)</td>
<td>40.5</td>
<td>31.4</td>
</tr>
<tr>
<td></td>
<td>Write Data Valid to T1 Start</td>
<td>21</td>
<td>16.4</td>
</tr>
<tr>
<td></td>
<td>Address Valid to READY#</td>
<td>38</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Address Valid to NA#</td>
<td>25</td>
<td>19</td>
</tr>
</tbody>
</table>

**Notes:** Time is shown in ns; the "-" entry means unspecified.
Signal loading specifications

*(Compares Intel 80386DX Processor to Emulator)*

<table>
<thead>
<tr>
<th>Signal</th>
<th>I/O</th>
<th>80386DX Rating</th>
<th>Emulator Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><em>Out: $I_{OL}/I_{OH}$, Max Load pF</em></td>
<td><em>Out: $I_{OL}/I_{OH}$, Max Load pF</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>In: $I_n/I_{IH}$, Cap</em></td>
<td><em>In: $I_n/I_{IH}$, Cap</em></td>
</tr>
<tr>
<td>A[31:2]</td>
<td>output</td>
<td>4mA/1mA, 50pF</td>
<td>4mA/1mA, 37pF</td>
</tr>
<tr>
<td>D[31:0]</td>
<td>I/O</td>
<td>Out: 4mA/1mA, 50pF  In: 200μA/400μA, 10pF</td>
<td>Out: 64mA/32mA, 50pF  In: 100μA/100μA, 8pF</td>
</tr>
<tr>
<td>BE0#-BE3#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>4.9mA/0.8mA, 42pF</td>
</tr>
<tr>
<td>W/R#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>4.8mA/0.7mA, 38pF</td>
</tr>
<tr>
<td>D/C#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>5mA/0.9mA, 50pF</td>
</tr>
<tr>
<td>M/IO#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>4.9mA/0.8mA, 32pF</td>
</tr>
<tr>
<td>LOCK#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>5.9mA/0.8mA, 42pF</td>
</tr>
<tr>
<td>ADS#</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>64mA/32mA, 50pF</td>
</tr>
<tr>
<td>HLDA</td>
<td>output</td>
<td>5mA/0.9mA, 50pF</td>
<td>64mA/32mA, 50pF</td>
</tr>
<tr>
<td>PREQ</td>
<td>input</td>
<td>-200μA (w/internal pull down)</td>
<td>-210μA, +15pF</td>
</tr>
<tr>
<td>BS16#, NA#</td>
<td>input</td>
<td>400μA/15μA, 10pF</td>
<td>100μA/100μA, 15pF (1 load)</td>
</tr>
<tr>
<td>BUSY#, ERROR#</td>
<td>input</td>
<td>400μA/15μA, 10pF</td>
<td>410μA/25μA, 25pF</td>
</tr>
<tr>
<td>HOLD</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>15μA/15μA, 10pF</td>
</tr>
<tr>
<td>READY#</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>100μA/100μA, 15pF (1 load)</td>
</tr>
<tr>
<td>CLK2</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>2 beefgate loads</td>
</tr>
<tr>
<td>INTR</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>20μA/20μA, 30pF</td>
</tr>
<tr>
<td>NMI</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>10μA/10μA, 15pF</td>
</tr>
<tr>
<td>RESET</td>
<td>input</td>
<td>15μA/15μA, 10pF</td>
<td>100μA/10μA, 8pF</td>
</tr>
</tbody>
</table>
Physical

Emulator Dimensions
173 mm height x 325 mm width x 389 mm depth (6.8 in. x 12.8 in. x 15.3 in.)

Emulator Weight
Probe alone: 0.3 kg (10 oz).

Cable Length
Emulation Control Card to Probe, approximately 914 mm (36 inches).

Probe dimensions
Environmental

**Temperature**
Operating, 0° to +40° C (+32° to +104° F).
Nonoperating, -40° C to +60° C (-40° F to +140° F).

**Altitude**
Operating/nonoperating 4600 m (15 000 ft).

**Relative Humidity**
15% to 95%.

Regulatory compliance

**Electromagnetic Interference**
VDE 0871/6.78 Level A.

**Safety Approvals**
Self-certified to UL 1244, IEC 348, CSA 556B; meets IEC 380 for line isolation.
BNC, labeled TRIGGER IN/OUT

**Output Drive**
Logic high level with 50-ohm load $\geq 2.0\text{V}$.
Logic low level with 50-ohm load $\leq 0.4\text{V}$.

**Input**
74HCT132 with 135 ohms to ground in parallel.

**Maximum input:**
5V above Vcc; 5V below ground.

---

**Communications**

**Host Port**
25-pin female type “D” subminiature connector.
RS-232-C DCE or DTE to 38.4 kbaud.
RS-422 DCE only to 460.8 kbaud.

**Auxiliary Port (64700A Only)**
25-pin female type “D” subminiature connector.
RS-232-C DCE only to 19.2 kbaud.

**CMB Port**
9-pin female type “D” subminiature connector.
Glossary

Absolute Count
A count in the trace list count column that indicates the total count accumulated between the displayed state and the trigger state.

Absolute File
A file consisting of machine-readable instructions in which absolute addresses are used to store instructions, data, or both. These files are generated by the compiler/assembler/linker and are loaded into the emulator.

Access Breakpoint
A break from execution of your target program to execution of the emulation monitor when the emulator detects a read or write of an address or range of addresses.

Access Mode
Specifies the types of cycles used to access target system memory locations. For example a "byte" access mode tells the monitor program to use move byte instructions to access target memory.

Analyzer
An instrument that captures activity of signals synchronously with a clock signal. An emulation-bus analyzer captures emulator bus cycle information. An external analyzer captures activity on signals external to the emulator.
Analyzer Clock Speed

The bus cycle rate of the emulation processor. If the emulation processor is running at 21 MHz and the fastest bus cycle requires three clocks, then the analyzer clock speed (bus cycle rate) is \( \frac{21}{3} = 7 \) MHz.

Arm Condition

A condition that reflects the state of a signal external to the analyzer. The arm condition can be used in branch or storage qualifiers. External signals can be from another analyzer or an instrument connected to the CMB or BNC.

Assembler

A program that translates symbolic instructions into object code.

Background

The emulator mode in which foreground operation is suspended so the emulation processor can be used for communication with the emulation controller. The background monitor does not occupy any processor address space.

Background Memory

Memory space reserved for the emulation processor when it is operating in the background mode. Background memory does not take up any of the microprocessor’s address space.

Background Monitor

A monitor program that operates entirely in background memory. The background monitor can execute when target program execution is temporarily suspended. The background monitor does not occupy any of the address space that is available to your target program.
**BNC Connector**

A connector that provides a means for the emulator to drive/receive a trigger signal to/from an external device (such as a logic analyzer, oscilloscope, or HP 64000-UX system).

**Breakpoint**

A point at which emulator execution breaks from the target program and begins executing in the monitor. (See also Execution Breakpoint and Access Breakpoint.)

**Command File**

A file containing a sequence of commands to be executed.

**Compatible Mode**

The compatible mode of the deep analyzer configures the analyzer to provide the same memory depth as the 1K analyzer: 1024 states deep when the analyzer is not configured to make a count of states or time during a measurement, and 512 states deep when the analyzer is configured to make a count of states or time during a measurement. If the emulator interface you are using along with the deep analyzer requires that you use the compatible mode, the deep analyzer will still be able to provide one of its benefits for your measurement; you will be able to make your counts of states or time at full emulator clock speed.

**Compiler**

A program that translates high-level language source code into object code, or produces an assembly language program with subsequent translation into object code by an assembler. Compilers typically generate a program listing which may list errors displayed during the translation process.
Counter Overflow

When the counter reaches maximum count and begins a new
count from zero. The counter of the deep analyzer simply counts
continuously once a trace begins; it increments its count every
20 ns, and reaches maximum count in about 22.9 minutes
(22 minutes and 54 seconds). The deep analyzer sets a flag in
memory and stores it along with the first state that is captured
after the counter overflow occurs (first state captured after the
counter begins again at zero).

Configuration File

A file in which configuration information is stored. Typically,
configuration files can be modified and re-loaded to configure
instruments (such as an emulator) or programs (such as the PC
Interface).

Coordinated Measurement

A synchronized measurement made between the emulator and
analyzer, between emulation-bus analyzer and external analyzer,
or between multiple emulators or analyzers. For example, a
coordinated measurement is made when two or more HP 64700
emulators/analyzers start executing together, or break into
background monitors at the same time.

Coordinated Measurement Bus (CMB)

The bus that is used for communication between multiple HP
64700 Series emulators/analyzers or between HP 64700
emulators/analyzers and an HP 64306 IMB/CMB Interface to allow
coordinated measurements.

Cross Trigger

The situation in which the trigger condition of one analyzer is
used to trigger another analyzer. Two signals internal to the HP
64700 can be connected through the BNC on the instrumentation
card cage to allow cross-triggering between the emulation-bus
analyzer and other analyzers.
DCE (Data Communications Equipment)
A specific RS-232C hardware interface configuration. Typically, DCE is a modem.

Deep Analyzer
In this manual, the term "deep analyzer" refers to the HP 64794 Emulation-Bus Analyzer with deep trace memory.

Display Mode
When displaying memory, this mode tells the emulator the size of the memory locations to display. When modifying memory, the display mode tells the emulator the size of the values to be written to memory.

Downloading
The process of transferring absolute files from a host computer into the emulator.

DTE (Data Terminal Equipment)
A specific RS-232C hardware interface configuration. Typically, DTE is a terminal or printer.

Embedded Microprocessor System
The microprocessor system which the emulator plugs into.

Emulation Bus Analyzer
A system component built into the HP 64700 that captures the emulation processor's address, data, and status information.

Emulation Memory
High-speed memory (RAM) in the emulator that can be used in place of target system memory.
Emulator

An instrument that performs just like the microprocessor it replaces, but at the same time, it gives you information about the operation of the processor. An emulator gives you control over target system execution and allows you to view or modify the contents of processor registers, target system memory, and I/O resources.

Emulator Probe

The assembly that connects the emulator to the target system microprocessor socket.

Escape Sequence (transparent mode)

A keyboard input consisting of a special sequence of characters, beginning with the escape character (1C hexadecimal). This sequence is used to access an emulator while in transparent mode. When using multiple emulators and transparent mode to access the different emulators, each one must be given a unique escape character.

Execution Breakpoint

A special instruction placed in your software in RAM, replacing the normal instruction at the RAM address. Breakpoints for code in ROM are implemented by the i80386. When the breakpoint instruction is executed, emulation immediately transfers from execution of your target program to execution of the emulation monitor.

Expression

The information that can fit into a single pattern or a single range (a pattern such as addr=2105, data!=15, or a range such as addr=4012..401a). A complex expression is made up of pattern, range, and arm labels joined together by various operators that define the specific condition. Each of the pattern and range labels must be previously assigned to specific simple expressions using the terminal interface commands: tpat and trng.
**Foreground**

The mode in which the emulator is executing the user program. In other words, the mode in which the emulator operates as the target microprocessor would.

**Foreground Monitor**

A monitor program that executes in the foreground address space. When the monitor exists in foreground, it is directly accessible by, and can interact with, your target program.

**Guarded Memory**

An address range that is to be inaccessible to the emulation processor. The emulator will generate a break and display an error message if an access to guarded memory occurs.

**Handshaking**

A process that involves receiving and/or sending control characters which indicate a device is ready to receive data, that data has been sent, and that data has been accepted.

**Host Computer**

A computer to which an HP 64700 Series emulator can be connected. A host computer may run interface programs which control the emulator. Host computers may also be used to develop programs to be downloaded into the emulator.

**Inverse Assembler**

A program that translates absolute code into assembly language mnemonics.

**Label**

A set of one or more analyzer channels. Example, the label "addr" is used to identify the analyzer channels connected to the address bus of the emulation processor.
**Linker**

A program that combines relocatable object modules into an absolute file which can be loaded into the emulator and executed.

**Logical Address Space**

The addresses assigned to code during the process of compiling, assembling and linking to generate absolute files.

**Macros**

Custom made commands that represent a sequence of other commands. Entire sequences of commands defined in macros will be automatically executed when you enter the macro name. Macro nesting is permitted; this allows a macro definition to contain other macros.

**Memory Mapper Term**

A number assigned to a specific address range in the memory map. Term numbers are consecutive.

**Memory Mapping**

Defining ranges of the processor address space as emulation RAM or ROM, target RAM or ROM, or guarded memory.

**Monitor Program**

A program executed by the emulation processor that allows the emulation system controller to access target system resources. For example, when you display target system memory locations, the monitor program executes microprocessor instructions that read the target memory locations and send their contents to the emulation controller.

**Operating System**

Software which controls the execution of computer programs and the flow of data to and from peripheral devices.
**Overflow**

See counter overflow.

**Parity Setting**

The configuration of the parity switches. Depending on the configuration of the parity output switch and the parity switch, a parity check bit is added to the end of data to make the sum of the total bits either even or odd. A parity check is performed after data has been transferred, and is accomplished by testing a unit of the data for either odd or even parity to determine whether an error has occurred in reading, writing, or transmitting the data.

**Path**

Also referred to as a directory (for example `\users\projects`).

**Pass Through Mode**

See Transparent Mode.

**PC Interface**

A program that runs on the HP Vectra and IMB PC/AT compatible computers. This is a friendly interface used to operate an HP 64700 Series emulator.

**Performance Verification**

A program that tests the emulator to determine whether the emulation and analysis hardware is functioning properly.

**Physical Address Space**

The address space in hardware memory and hardware I/O that is accessed by the microprocessor during normal program execution.
P/O

An abbreviation for "part of." Used in illustrations to show that a part is shipped with other parts under a certain HP part number.

Prefetch

The ability of a microprocessor to fetch additional opcodes and operands before the current instruction is finished executing.

Prestore

The storage of states captured by the analyzer that precede states which are normally stored. If the normal storage qualifier specifies the entry address of a function or routine, prestore can be used to identify the callers of that function or routine.

Prestore Qualifier

A specification that must be met by a state before it can be saved in the analyzer prestore memory.

Primary Sequencer Branch

Occurs when the analyzer finds the primary branch state specified at a certain level and begins searching for the states specified at the primary branch’s destination level.

Qualifier

A specification that must be met before an action can be taken by the analyzer. For example, a store qualifier is a specification that must be met by an incoming state before it can be stored in the trace memory. The "arm" condition can be used as an additional qualifier. For example, an external analyzer may be set up to supply a true signal to the rear panel BNC connector on the card cage when it detects a true condition in the target system. Then the analyzer can be set up to store qualify a certain kind of state, but only when the arm signal from the BNC is true.
Real-Time Execution

Continuous execution of the user program without interference from the emulator. (Such interference occurs when the emulator temporarily breaks into the monitor so that it can access register contents or target system memory or I/O.)

Relative Count

A count in the trace list count column that shows the count between the present displayed state and the state displayed immediately before it. Relative time count, for example, shows the elapsed time between the previous displayed state and the present state. Note that the count is between displayed states. If your trace list is inverse assembled and/or dequeued, several states may have been captured in memory between the present displayed state and the displayed state immediately before it.

Remote Configuration

The configuration in which an HP 64700 Series emulator is directly connected to a host computer via a single port. Commands are entered (typically from an interface program running on the host computer) and absolute code is downloaded into the emulator through that single port.

RS-232C

A standard serial interface used to connect computers and peripherals.

Secondary Sequencer Branch

Occurs when the analyzer finds the secondary branch state specified at a certain level before it found the primary branch state and begins searching for the states specified at the secondary branch’s destination level.

Sequencer

The part of the analyzer that allows it to search for a certain sequence of states before triggering.
Single-step

The execution of one microprocessor instruction. Single-stepping the emulator allows you to view program execution one instruction at a time.

Software Breakpoint

Refer to execution breakpoint and access breakpoint in this glossary.

Software Performance Analyzer

An analyzer that measures execution of software modules, interaction between software modules, and usage of data points and I/O ports.

Standalone Configuration

The configuration in which a data terminal is used to control the HP 64700 Series emulator, and the emulator is not connected to a host computer.

stderr

An abbreviation for “standard error output.” Standard error can be directed to various output devices connected to the HP 64700 ports.

stdin

An abbreviation for “standard input.” Standard input is typically defined as your computer keyboard.

stdout

An abbreviation for “standard output.” Standard output can be directed to various output devices connected to the HP 64700 ports.
**Step**


**Store Qualifier**

A specification that must be met by a state before it can be saved in the analyzer trace memory.

**Synchronous Execution**

The execution of multiple HP 64700 Series emulators/analyzers at the same time (i.e., multiple emulator start/stop).

**Syntax**

The order in which expressions are structured in command languages. Syntax rules determine which forms of command language syntax are grammatically acceptable.

**Target Program**

The program you are developing for your product. It is also called user program.

**Target System**

The circuitry where the emulator probe is connected (typically a microprocessor-based system under development).

**Target System Memory**

Storage that is present in the target system.

**Terminal Interface**

The command interface present inside the HP 64700 Series emulators that is used when the emulator is connected to a simple data terminal. This interface provides on-line help, command recall, macros, and other features which provide for easy command entry from a terminal.
Trace

A collection of states captured synchronously by the analyzer.

Transparent Configuration

The configuration in which the HP 64700 Series emulator is connected between a data terminal and a host computer. When the emulator is in the transparent (pass through) mode, the data terminal acts like a normal terminal connected to the computer. In this configuration, you can develop code on the host computer and download absolute code into the emulator for debugging and testing.

Transparent Mode

The emulator mode in which all characters received on one port will be copied to the other port. This mode allows a data terminal (connected to one emulator port) to access a host computer (connected to the other emulator port) through the emulator.

Trigger

The condition that identifies a reference state within an analyzer trace measurement. Trigger also refers to the analyzer signal that becomes active when the trigger condition is found.

Trigger signals called trig1 and trig2 are bidirectional signal lines that can be used to coordinate measurement activity between emulators and analyzers installed in the instrumentation card cage, and between instruments connected to the BNC on the rear panel of the card cage.

Note that there is a delay when you use a trigger for measurement coordination. For example, you may specify that the emulator break to its monitor program when it receives trig1 from the analyzer. Several states may be executed in the emulator between the time the analyzer recognizes its trigger condition, generates trig1, delivers trig1 to the emulator, and the emulator responds to trig1 by breaking to its monitor program.
Uploading

The transfer of emulation or target system memory contents to a host computer.

Unlocked Exit

One of two methods used to leave the high level (Graphical or Softkey) Interface and return to the host computer operating system. An unlocked exit command allows you to exit the high level interface and re-enter later with the default configuration. (See also Locked Exit.) This is not available in the Terminal Interface.

User Program

Another name for your target program (the program you are developing for your product.

Viewport

See Window.

Wait States

Extra microprocessor clock cycles that increase the total time of a bus cycle. Wait states are typically used when slower memory is implemented.

Window

A specified rectangular area of virtual space shown on the display in which data can be observed.

1K Analyzer

The term "1K analyzer" refers to the HP 64704 Emulation-Bus Analyzer with 1K trace memory.

When shown in the trace list count column of the terminal interface or the PC interface, the exclamation mark "!" indicates counter overflow.
Index

A  access size (target memory), 127
    altitude specifications, 124
    analyzer cable, 18
    analyzer clock speed, definition, 128
    AUI connector, 32
        on LAN board, 33
    AUTOEXEC.BAT file, editing, 86
    1K analyzer, definition of, 141

B  background, definition of, 128
    BNC connector, 32
    breakpoints, 74
    built-in interface
        See terminal interface

C  cables
    80-channel analyzer card, 18
    connecting to the emulator probe, 9-10
    power, 28
    card cage
        applying power, 28-29, 43
        different models, 5
        removing cover, 12
    cards
        installing in card cage, 18
        removing from card cage, 14
    cautions
        antistatic precautions, 6
        electrostatic discharge on LAN, 33
        pin 1 alignment, 49
        rear panel, do not stand HP 64700 on, 11
        target power not detected, 55
        turn off power, 47
        wear static strap, 48
Index

circuits, interfacing target with processor, 77
CLK2, specifying clock speed, 63
clocks, specifications, 118
CMB (Coordinated Measurement Bus), specifications, 125
commands
  help, 112-113
  terminal interface, 112-113
  See also the name of the individual command
CONFIG.SYS file, editing, 86
configuration, system, 32
connecting emulator probe
  flexible cable, 48
  limitations and constraints, 48
  to demo target system, 41
  using no emulation monitor, 48-62
connections
  See host computer, connecting to
counter overflow indication not seen in trace list, 102
counts, negative counts in count column, 102
cover, removing, 12

D  data communications specifications, 125
deep analyzer, definition of, 131
default installation path, 85
demo target system
  connecting power, 19
  connecting the emulator probe, 41
depth, increasing memory, 7-8
display mode, 131

E  electrical specifications
  ac specifications, 120-121
electromagnetic interference specifications, 124
emulation memory modules, installing, 24
emulator
  displaying status information, 96
  firmware floppy disks, 82
  performance verification, 91-93
emulator probe
  connecting to demo target system, 41
  See probe

environment variables
  HP64700, 86
  HPTABLES, 86
  PATH, 85-86
  PROGFLAS.EXE, 86

plugin, 47
  equipment needed during plugin, 47
  equivalent circuits target-to-processor, 77
  es (emulator status) command, 96
  ethernet address, 34
  exchange part, defined, 104
  exclamation mark "!" in trace list count column, 101
  execution start, if you are having problems, 58

F
  failures reported by performance verification, 102

firmware update
  connecting the HP 64700 to the PC, 83-84
  installing the utility, 85-86
  using PROGFLASH to update, 87

flash card, installing in HP 64700A, 21

FLASH.BAT file, editing, 86

flexible cable, 48
  effect on target connection, 49

flying lead, reset, 75-76

foreground monitor
  considerations when using paging, 69
  dealing with keep-alive circuitry, 72-73
  monitor address, 69
  monitor selector, 70

G
  gateway address, 35

  glossary, 127-141
  ground strap plug on rear panel, 11-23
Index

H  hardware, HP 9000 minimums overview, 4
   help, on-line help command, 112-113
   host computer, connecting to, 31-38
   HP 64700 firmware update
      connecting the HP 64700 to the PC, 83-84
      installing the update utility, 85-86
      using PROGFLASH, 87
   HP 9000 minimum system requirements overview, 4
   HP64700 environment variable, 86
   HPTABLES environment variable, 86
   humidity specifications, 124

I  idle cycle appears during a jump, 74
   installation, 4
      analyzer memory modules, 7-8
      emulation memory modules on probe, 24-27
      hardware, 5
      placing boards in the card cage, 11-23
      probe into demo board, 40-44
      verifying installation of memory modules, 92
   installation path, default, 85
   interfaces
      graphical, 115
      terminal, 109-115
   interfacing target with processor, 77
   internet address, 35, 38

J  jump causes appearance of an idle cycle, 74

K  keep-alive circuitry when using a foreground monitor, 72-73
   keep-alive timer
      to access the keep-alive address, 73
      to disable and enable on entry, 73

L  LAN
   connecting to, 31-38
   installing LAN card in HP 64700A, 21
   parameters, 34-37
   lead, reset flying, 75-76
   link level address, 34
   list of replaceable parts, 104
M  MAU, 32
    memory modules
        installing on analyzer card, 7-8
        installing on the emulation probe, 24-27
        verifying installation, 92
    messages, execution, 74
    monitor
        dealing with keep-alive circuitry, 72-73
        foreground monitor address, 69
        monitor selector, 70

N  negative counts in trace list count column, 102

O  overflow, definition of, 135

P  P/O (part of), 136
    paging when using the foreground monitor, 69
    parts, minimum system, 5
    parts list, 104
    path, installation, default, 85
    PATH environment variable, 85-86
    PC interface, 115
    performance verification, 44, 91-93
        list of tests performed, 93
        report of massive failures, what to check, 102
    plug-in to target system
        connection types, 48
        no monitor, 48-62
        using the background monitor, 68
        using the foreground monitor, 69-71
    emulator, 45-78
    target system, 45-78
    plugging the emulator into a target system, 45-78
    power applied to the card cage, 28-29, 43
    power cable
        connecting demo board power cable, 19
        connecting to card cage, 28
    probe
        connecting the cables, 9-10
        connecting to demo target system, 41
        dimensions, 123
        installing emulation memory modules, 24-27
Index

problem solving
  if the analyzer won’t trigger, 100
  if you see unexplained states in the trace list, 101
  if you suspect the emulator is broken, 97
  if you’re having problems with DMA, 100
problems
  during execution start, 58
  processor wait state, 57
  specifying a CLK2 speed, 63
  Target CLK2 not detected, 56
  target power not detected, 55
  Target RESET not released, 57
PROGFLAS.EXE environment variable, 86
PROGFLASH firmware update utility, 87

Q quick reference, 112-113

R READY# requirements when using 4-Mbyte SIMMs, 63
  rear panel, location of ground strap plug, 11-23
  reset flying lead, 75-76

S safety approvals, 124
  service ports, TCP, 36
signals
  interfacing target with processor, 77
  loading specifications, 122
SIMMs, 4-Mbyte, effects on READY# signal, 63
software, ensuring compatibility, 94
software breakpoints, 74
specifications
  ac electrical specifications, 120-121
  altitude, 124
  clock, 118
  CMB, 125
  data communications, 125
  electromagnetic interference, 124
  humidity, 124
  probe dimensions, 123
  safety approvals, 124
  signal loading, 122
  temperature, 124
  trigger in/out, 125

148
StarLAN, 33
starting execution, if you are having problems, 58
status
  processor wait state, 57
  target power not detected, 55
  Target RESET not released, 57
subnet mask, 35
system configuration, 32
system requirements, HP 9000 overview, 4

T
TCP service ports, 36
telnet, 37-38, 111
  command, 111
temperature specifications, 124
terminal interface, 109-115
  help command, 112-113
  starting, 111
  when to use, 110
test performance verification reports massive failures, what to check, 102
testing emulator performance, 91-93
tests performed by performance verification, 93
ThickLAN, 33
ThinLAN, 32-33
time, negative times shown in count column, 102
trigger in/out specifications, 125
troubleshooting, 94

U
upgrading, 6
user program, 133

V
ver (display software version numbers) command, 96
verification of performance, report of massive failures, what to check, 102
verifying emulator performance, 91-93
verifying installation of memory modules, 92
version checking, 96

W
warnings, power must be OFF during installation, 11
watchdog timer
  access the keep-alive address, 73
  to disable and reenable on entry, 73
  when using a foreground monitor, 72-73
Windows interface, 115
Certification and Warranty

Certification

Hewlett-Packard Company certifies that this product met its published specifications at the time of shipment from the factory. Hewlett-Packard further certifies that its calibration measurements are traceable to the United States National Bureau of Standards, to the extent allowed by the Bureau's calibration facility, and to the calibration facilities of other International Standards Organization members.

Warranty

This Hewlett-Packard system product is warranted against defects in materials and workmanship for a period of 90 days from date of installation. During the warranty period, HP will, at its option, either repair or replace products which prove to be defective.

Warranty service of this product will be performed at Buyer’s facility at no charge within HP service travel areas. Outside HP service travel areas, warranty service will be performed at Buyer’s facility only upon HP’s prior agreement and Buyer shall pay HP’s round trip travel expenses. In all other cases, products must be returned to a service facility designated by HP.

For products returned to HP for warranty service, Buyer shall prepay shipping charges to HP and HP shall pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping charges, duties, and taxes for products returned to HP from another country. HP warrants that its software and firmware designated by HP for use with an instrument will execute its programming instructions when properly installed on that instrument. HP does not warrant that the operation of the instrument, or software, or firmware will be uninterrupted or error free.
Limitation of Warranty

The foregoing warranty shall not apply to defects resulting from improper or inadequate maintenance by Buyer, Buyer-supplied software or interfacing, unauthorized modification or misuse, operation outside of the environment specifications for the product, or improper site preparation or maintenance.

No other warranty is expressed or implied. HP specifically disclaims the implied warranties of merchantability and fitness for a particular purpose.

Exclusive Remedies

The remedies provided herein are buyer's sole and exclusive remedies. HP shall not be liable for any direct, indirect, special, incidental, or consequential damages, whether based on contract, tort, or any other legal theory.

Product maintenance agreements and other customer assistance agreements are available for Hewlett-Packard products.

For any assistance, contact your nearest Hewlett-Packard Sales and Service Office.
Safety

Summary of Safe Procedures

The following general safety precautions must be observed during all phases of operation, service, and repair of this instrument. Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety standards of design, manufacture, and intended use of the instrument. Hewlett-Packard Company assumes no liability for the customer's failure to comply with these requirements.

Ground The Instrument

To minimize shock hazard, the instrument chassis and cabinet must be connected to an electrical ground. The instrument is equipped with a three-conductor ac power cable. The power cable must either be plugged into an approved three-contact electrical outlet. The power jack and mating plug of the power cable meet International Electrotechnical Commission (IEC) safety standards.

Do Not Operate In An Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes. Operation of any electrical instrument in such an environment constitutes a definite safety hazard.
Keep Away From Live Circuits

Operating personnel must not remove instrument covers. Component replacement and internal adjustments must be made by qualified maintenance personnel. Do not replace components with the power cable connected. Under certain conditions, dangerous voltages may exist even with the power cable removed. To avoid injuries, always disconnect power and discharge circuits before touching them.

Designed to Meet Requirements of IEC Publication 348

This apparatus has been designed and tested in accordance with IEC Publication 348, safety requirements for electronic measuring apparatus, and has been supplied in a safe condition. The present instruction manual contains some information and warnings which have to be followed by the user to ensure safe operation and to retain the apparatus in safe condition.

Do Not Service Or Adjust Alone

Do not attempt internal service or adjustment unless another person, capable of rendering first aid and resuscitation, is present.

Do Not Substitute Parts Or Modify Instrument

Because of the danger of introducing additional hazards, do not install substitute parts or perform any unauthorized modification of the instrument. Return the instrument to a Hewlett-Packard Sales and Service Office for service and repair to ensure that safety features are maintained.

Dangerous Procedure Warnings

Warnings, such as the example below, precede potentially dangerous procedures throughout this manual. Instructions contained in the warnings must be followed.

---

Warning

Dangerous voltages, capable of causing death, are present in this instrument. Use extreme caution when handling, testing, and adjusting.
Safety Symbols Used In Manuals

The following is a list of general definitions of safety symbols used on equipment or in manuals:

Instruction manual symbol: the product is marked with this symbol when it is necessary for the user to refer to the instruction manual in order to protect against damage to the instrument.

Hot Surface. This symbol means the part or surface is hot and should not be touched.

Indicates dangerous voltage (terminals fed from the interior by voltage exceeding 1000 volts must be marked with this symbol).

Protective conductor terminal. For protection against electrical shock in case of a fault. Used with field wiring terminals to indicate the terminal which must be connected to ground before operating the equipment.

Low-noise or noiseless, clean ground (earth) terminal. Used for a signal common, as well as providing protection against electrical shock in case of a fault. A terminal marked with this symbol must be connected to ground in the manner described in the installation (operating) manual before operating the equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment which normally includes all exposed metal structures.

Alternating current (power line).

Direct current (power line).

Alternating or direct current (power line).
Caution

The Caution sign denotes a hazard. It calls your attention to an operating procedure, practice, condition, or similar situation, which, if not correctly performed or adhered to, could result in damage to or destruction of part or all of the product.

Warning

The Warning sign denotes a hazard. It calls your attention to a procedure, practice, condition or the like, which, if not correctly performed, could result in injury or death to personnel.